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Dear Sir / Madam,

 This handbook aims to help the teachers to concentrate more on the practical side. 

The teachers have to particularly note that in the lower classes especially in the first and 

second standards, it is meant to give an awareness of the computer and it is not at all 

necessary to by heart the computer parts or computer related terms. They mustn't feel 

computer study a burden. Otherwise let them feel enjoyable their studies.It is not mere a 

computer study but a concrete foundation for their higher studies through the simple basic 

programming technics.

Thanking You,

                          Team EDUFY

All rights reserved. No parts of this publication may be reproduced, stored in a 

retrieval system and  transmitted in any form or by any means, electronic, 

mechanical, photocopying, recording or otherwise, without the prior written 

permission of the publishers.
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BOOKS TERM I      TERM II TERM III

                                                    ( AUGUST) (DECEMBER) (MARCH)

LESSONS      LESSONS LESSONS

BOOK 1 1, 2 3, 4  5, 6

BOOK 2 1, 2 3,4,5             6, 7

BOOK 3 1, 2 3,4,5             6, 7

BOOK 4 1, 2 3,4,5             6, 7

BOOK 5 1, 2, 3     4,5,6             7,8

BOOK 6 1, 2, 3     4, 5,6             7, 8

BOOK 7 1, 2, 3     4, 5,6             7, 8

BOOK 8 1, 2, 3     4, 5,6             7, 8

THREE TERM SCHEME

SCHEME OF EXAMINATION

TWO TERM SCHEME
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BOOK 5 1, 2, 3,4 5, 6, 7, 8

BOOK 6 1, 2, 3,4 5, 6, 7, 8

BOOK 7 1, 2, 3,4 5,6, 7, 8

BOOK 8 1, 2, 3,4 5, 6, 7,8

Note: Questions for each terminal examination cover only the portions prescribed for it.  Note: Questions for each terminal examination cover only the portions prescribed for it.  
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I on the blank space.

1) Calculate 2) Watch News 3) Travel 4) Find time

II Fill in the blanks with suitable letters

1) B 2) D 3) A 4) E 5) C 6) F

III Check whether true of false

1) False 2) False 3 True

IV Identify the following things and write N for Natural things and M for Man-made 

things

V Find out the odd one

VI Colour the picture and tick the right option

VIII What comes next?

IX  Answer the following

1 Cat and Tree

 2 Computer

I Name  each  computer  part

1) Monitor 2) CPU 3) Mouse 4) Keyboard

II Fill the crossword

Write the right number 

N M M N N MN

1 2 3

natural thing

ITG-I 1 HELLO COMPUTER
III Fill in the blanks with suitable letters

3 Monitor looks like a television 4 Keyboard is used to write letters

IV Match the picture with related computer parts

V Find out how many computer parts are given below

1) 2) 3)

I Connect computer with its features and functions

II Check whether true (   ) or false (   )

III Find out odd one

IV Find out the given words

V Fill in the blank with suitable numbers

1) Letters 2) Songs 3) Games 4) Call 5) Write 6) Pictures

I Mark (   ) on the image related with mouse

Dragging Single click    Mousepad        Wheel     Left Button

1 Mouse looks like a rat 2 CPU is the brain of a computer

ITG-I 2 PARTS OF A COMPUTER

ITG-I 3 FUNCTIONS OF COMPUTERS
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II Fill in the blanks

1) Play Game   2) Keyboard, Mouse, Monitor, CPU    3) CD/DVD drive     4) Scan

III True or false 1) True      2) False 3)True

IV Fill the crossword

V Identify the parts of a computer   

1) Scanner    2) Joystick    3) Pen drive     4) Printer

VI Match the following

1) Hospital    2) Designing         3) Office          4) Home           5) Railway Station

VII Connect with related features

Bank (5,6) Home (2,1) School (4,3)

VIII Find out and round the given words in the letter grid

IX Identify the places

1) Textiles 2) Hospital 3) Printing     4) School    5) Home    6) Bank 

7) Office 8)Railway station 9) Airport

I Rearrange the steps to switch ON a computer

1) Turn On Main Supply    2) Turn On UPS   3) Turn On CPU    4) Turn On Monitor

II Arrange the block in the right order to get names of electronic devices

1) Mainframe 2) Television 3) Desktop 4 Palmtop

III Number the device according to their size
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ITG-II 2 COMPUTER WORLD

1 2 3 4 5

8 9

II Mark (   ) on the image related with Keyboard

Numeric keys                Special keys                Alphabetic keys     Function keys

III Fill in the blanks with suitable letters 

1) Wheel 2) Mouse 3) Mousepad       4) Left Button   5) Alphabetic keys

6) Numeric keys 7) Keyboard

IV Match the following

1) Wheel     2) Right Click 3) Single Click 4) Numeric Keys 5) Keyboard

I Tick on the right statement

1) (    ) 2) (   ) 3) (    )

II Tick the correct one

Start Windows Accessories Paint

III Fill in the blanks with suitable numbers

1) Tools group 2) Colors group 3) Draw pictures 4) Paint

5) Start button 6) Tool box

LOGICAL REASONING
I Puzzle

Which is the top view? 1

II Match the cards

1) 2) 3) 4)

III How many? 15

IV Tick(   ) the correct option Answer : A

I         Fill in the blanks with suitable words

           1) b 2) d            3) c           4) a

II Connect with suitable numbers

Alexa-2 Robot-1 Drone-3 Google Assistant-4

III       Multiple choice questions 1) a 2) b            3) b           4) b

I Multiple choice questions

1) Smart classroom   2) Scanning        3) Emigration     4) ATM

ITG-I 5 STARTING WITH PAINT

ITG-I 6 ARTIFICIAL INTELLIGENCE

ITG-II 1 BEGINNING WITH COMPUTER

1 2 3 4
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ITG-II 3 WORKING OF A COMPUTER

IV Rearrange the steps to switch OFF a computer

1) Start Button      2) Power Button 3) Shut down button 4) Power of monitor

5) Power of UPS   6) Power off Main supply

V Match the following

VI Connect with related function

1) Do calculations    2) Call friends     3) Watch movies    4) Listen to music

VII True or False 1) False 2) True 3) False

VIII Answer the Following

1) Computer is an electronic device. It is used to play games, watch news and do 

    calculations. 
2) Super computer is the fastest and expensive computer used for scientific works. 

3) Computer is faster.

4) Plamtop computer is the smallest computer.

I Check whether True or False

1) False 2) True 3) False

II Fill the series

1) Processing  2)  Monitor  3)  Memory card  4) Speaker  5) CPU  6) Output  7) Hard disk

III Select suitable words from the list below and fill the blanks spaces

IV Connect the computer with related parts

1) Scanner     2) Printer    3) Speaker    4) Web camera    5) Keyboard   6) Mouse

V Name the following

Laptop Tablet Mainframe computerDesktop

Washing MachineKeyboard Computer Pen drive Mouse Joystick

I Fill in the blanks

1) Monitor 2) Silence    3) Dust covers 4) Clean and Neat

5) Computer table 6) Mousepad

II Tick whether Good or Bad behaviors

1) Good 2) Bad 3) Good 4) Good 5) Bad

III Tick the pictures with Good or Bad

IV Mark Good or bad behaviours

V Complete the Crossword

1) Computer lab 2) Mousepad 3) Clean 4) Distance

I Fill in the blanks

1) Spacebar 2) Numeric 3) Shift 4) Notepad

II Rearrange the steps to open Notepad   

1) Start button 2) Windows Accessories       3) Notepad

III Tick whether True or False    1) False     2) True    3) True        4) False    5) False

IV Identify the keys 1) Backspace key     2) Shift key     3) Delete key     4) Enter key

V Connect the bats with related halloween

1) Delete 2) Caps lock      3) Space bar 4) Enter key        5) F10

VI Match the following key

ITG-II 4 LAB CULTURE

x xx

ITG-II 5 KEYBOARD

3 1

5 2 4

10 11
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7 AI AROUND US ITG-II

I Who says true ? Tick on them  

1) 2) 3)

II Find out tools name?

III Fill in the blanks with suitable letters   

1) Oval 2) Rectangle 3) Line 4) Eraser

IV Answer the following

1) Pencil tool is used to draw pictures. 

2) Oval tool is used to draw ellipse and circles.

V Connect the tools with related angry birds

1) c 2) b 3) a 4) d 5) e

LOGICAL REASONING
A        What does not fit? 

          a - Carrot          b - Fire        c - Fruit

B        Find the missing piece of the picture

            Answer- c  

C        What images are missing in each line

1)                        2)                       3)                     4)                           5)

I          Fill in the blanks

           1) Sophia       2) Aibo       3) Chatbot     4) Robot      5) YouTube       6) Robotic Engineer

II         Write T for True and F for False        

1) F          2) T         3) F     4) F      5) T

ITG-II 6 MORE ON PAINT
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III         Match the following

 1 Sophia         2 Chatbots        3 Self Driving Car

IV         Rearrange the jumbled words

1 KURI         2 AIBO        3 ROBOT 

V      Answer the following

 1 No , Robots are not smarter than human. But some people say that robots are not as smart  

    as we think.

2 Robot is a  machine resembling a human being and able to replicate certain human 

                movements and functions automatically.

3 Artificial Intelligence is the intelligence of machines, that allows them to perform some 

    tasks which requires intelligence.

4  Sophia , Aibo, Kuri etc.

5  Chatbots, YouTube recommendations,  Self  Driving Car etc.

VI     Fill the crossword

        1 Robot 2 Sophia 3 Honda 4 Chatbots 5 Kuri 6 Aibo

I Write I for input devices and S for storage devices

1) I 2) S 3) I 4) I 5) S 6) S 7) I

II Who am I?

1) Memory 2) Webcam 3) Joystick 4) Plotter 

5) Delete 6) Keyboard 7) Barcode Reader 8) CPU

III Fill in the blanks

 1) Three       2) Function key       3) Biometric        4) Monitor      5) CPU        6) Output

IV Match the following

V Find out the Odd one

1) Speaker 2) Joystick 3) Function key 4) Delete

VI Pick out the right combination

VII Write the category of the following devices

1) Output 2) Storage 3) Output 4) Input 5) Output 6) Input

ITG-III I COMPUTER FUNDAMENTALS

1 4 3 2

12 13
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ITG-III 3 STARTING WITH TUX PAINT

I Multiple Choice Questions

1) Windows 10 2) Paint 3) Monitor 4) Bottom

II Fill in the blanks 1) Maximize   2) Application         3) System 4) Start

III Identify the following

1) This PC 2) Recycle Bin 3) Paint 4) Minimize  5) Close

IV Fill the crossword

V Find the names of icons

1) This PC    2) Paint 3) Recycle bin 4) Network

VI Answer the following

1) Application software are the programs used to perform specific tasks.

2) Software is a set of instructions to the computer to do a particular work . Windows 7 

    Paint, WordPad, Windows Media Player etc. are examples of software.

3) Hardware are physical components that make up of a computer system and can be seen 

    and touched.

VII Find out the odd one   1) Monitor 2) Keyboard 3) Windows

I Fill in the blanks

1) B 2) A 3) D 4) C

II Connect with suitable balloons

ITG-III 2 SOFTWARE AND HARDWARE

ITG-III 4 MORE ON TUX PAINT

III Match the tools with shapes

IV Match the tools with picture

I Name the Following

II Fill in the blanks with suitable words

A- Flower B- Magic C- Fill D- Quit

III Which tool you choose

Find out the tools you need to draw the following.

IV Find out what are they

1) Grass 2) Text 3) Stamp

V Answer the Following

1) Step 1: Click on the New tool

    Step 2: Select a colour for the new window.

    Step 3: Click on the Open button.

2) Fill tool, Flower tool, Grass and Noise.

3) Step 1: Click on Open tool from the Tools. 

    Step 2: Click Slides button available on the Open window.

    Step 3: Click on each image which you wish to display in slide show.

    Step 4: Adjust the speed of the slide show using sliding scale near to play button. 

    Step 5: Click on the Play button.

4) Flip tool is used to turn picture vertically. 

I Fill in the blanks

1) Two      2) Start Screen     3) Document     4) Minimize 5) Pin

ITG-III 5 MICROSOFT WORD 2016

14 15
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    Step 3: Click on the Open button.

2) Fill tool, Flower tool, Grass and Noise.

3) Step 1: Click on Open tool from the Tools. 

    Step 2: Click Slides button available on the Open window.

    Step 3: Click on each image which you wish to display in slide show.

    Step 4: Adjust the speed of the slide show using sliding scale near to play button. 

    Step 5: Click on the Play button.

4) Flip tool is used to turn picture vertically. 

I Fill in the blanks

1) Two      2) Start Screen     3) Document     4) Minimize 5) Pin
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II Multiple Choice Question

1) Start screen 2) Save 3) Maximize button 4) Tell me

III Match the following

1)Create a New document   2) Save the document    3) Open File   4) Print the document

IV State whether True or False

1) True 2) True 3) True 4) False    

V Identify the icons

VI Label the various parts of MS Word 2016 window shown below

VII Answer the following questions

1) Click on file tab and select close button or click on the close button on the title bar.

2) Click on start button and select Word 2016.

3) Click on the file tab on title bar. Click on the New option from the backstage view then 

    select the blank document

4) Click on File tab. Select Save/Save as button. Now a save pane will appear in backstage 

    click on the browse button type a name in the file name box, then click on the save button.

I Fill in the Blanks

1) Programming Language 2) Scratch 3) Sprite     4) View mode      5) Stamp  

II Match the Following

1) 2)  3)          4) 

5) 

III Name the Parts of the Scratch Window

1) Title bar   2) Menu bar   3) View mode   4) Green flag   5) Stop button   6) Black palette   

7) Block menu

IV Multiple Choice Questions 1) Title bar 2) Green flag 3) Pen down 4) Cat

V State  whether True or False

1) False 2) True 3) False 4) True 5) True

VI Answer the Following

1) Scratch is a multimedia programming language used to create games, animated stories

 ITG-III 7 ARTIFICIAL INTELLIGENCE

2) Presentation mode used when we want to present project on a full screen. View mode 

    is used to switch between full stage view/ small stage view.

3) Script Area is the place to  write step-wise instructions for Sprite to do a particular task. A 

               Script consists o at least two blocks. The script is created by dragging instructions from 

               the blocks palette and dropping them step wise on top of each other.

I       Fill in the blanks

        1  ................... jobs are tedious in nature.       ans) Repeate

        2  Mimic 3  Reasoning      4. Deep Blue        5. Adapt

II     Write T for True and F for False 1.T        2. F         3.  T        4. T        5.F

III     Find out the following

IV Match the following          

1 Chess    2 Reduction of errors    3 No emotion     4. Humanoid Robot       

V       Answer the following

      1  a. Handling repetitive job      b.  Reduction of errors

      2  AI can Sense, AI can Act, AI can Reason and AI can Adapt.

      3  Artificial Intelligence is the intelligence of machine that allows them  to perform some 

         tasks which require intelligence.

      4  a  AI -enabled machines incur heavy cost  b. AI-enabled machine may kill job  

    employments.

I True or False

1) True 2) True 3) True 4) True 5) False 6) False

II Identify the images and fill the boxes
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2) Presentation mode used when we want to present project on a full screen. View mode 

    is used to switch between full stage view/ small stage view.

3) Script Area is the place to  write step-wise instructions for Sprite to do a particular task. A 

               Script consists o at least two blocks. The script is created by dragging instructions from 

               the blocks palette and dropping them step wise on top of each other.
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IV Match the following          

1 Chess    2 Reduction of errors    3 No emotion     4. Humanoid Robot       

V       Answer the following

      1  a. Handling repetitive job      b.  Reduction of errors

      2  AI can Sense, AI can Act, AI can Reason and AI can Adapt.

      3  Artificial Intelligence is the intelligence of machine that allows them  to perform some 

         tasks which require intelligence.
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ITG-IV 2 MS WORD - EDITING FEATURES

III Fill in the blanks 

1) 

2) Task bar 3) Windows Keys +S     4) Task View       5) Cortana

IV Match the following

V Choose the correct answer

1) Personalize options      2) 3)          5) Win Key +C 6) 

VI Answer the following questions

1) Operating system software is a key part of all computers. It acts as a mediator 

    between the user and computer.

2) Click start button from start menu another way to open start menu is pressing the 

    windows key on the keyboard.

3) It is a voice activated personal digital assistant.

VII Match the tools and usages

1) Cortana  2) Task View  3) Open search box  4) Shut down    5) Screenshot

I Fill in the blanks

1) Editing     2) Keyboard 3) Enter key  4) Spacebar  5) Shift key 6) Tab key

II Choose the correct option

1) Delete 2) Caps lock key 3) Ctrl key 4) Copy 5) Editing

III Write what these tools do

1) Paste option      2) Cut option      3) Copy option      4) Undo     5) Redo  6) Find

IV Write the following select text using mouse with keyboard

1) Drag the mouse over the text     2) Double-click the word   3) Press and hold the Ctrl 

    key and press alphabetic key A   4)  To press and hold the Shift key and press the left 

    arrow key

V Match the following keys and its uses

1) Next stop     2) To move cursor to the next line     3) Bottom left and right corners of 

    keyboard      4) Short for Alternate key     5) To allow a single capital letter

VI Answer the following 

1) Enter Key, Delete or Backspace Key, Caps Lock Key, Shift Key, Ctrl Key, Alt Key 

2)Click on copy option on home tab or Shortcut key for copy is Ctrl+C you can also choose

.................. system software is a key part of all computers.- Operating

    copy option by right clicking on the selected text and right click on the desired area.

3) Select the text ,click on cut option on Home Tab. You can use Ctrl+x to cut. 

4) Select the text Computer, click on Copy option on Home Tab, then click on Paste option 

    on Home Tab.

5) Find option is used to find a particular word or text from a document. Replace option  

    helps you to replace any existing word with a new document.

I Fill in the blanks

1) Formatting     2) Paragraph      3) Font group      4) Line space   5) Shrink font

6) Grow font     7) Font group     8) Align right

II Identify the alignment option

a) Align Left      b) Center      c) Align Right          d) Justify

III Write shortcut key for the following

1) Ctrl+B 2) Ctrl+I 3) Ctrl+U 4) Ctrl+J 5) Ctrl+E 6) Ctrl+R

7) Ctrl+L 8) Ctrl+A

IV Match the following icons

1) Text effect     2) Font color      3) Text highlight color  4) Strikethrough

5) Change case   6) Center Alignment      7) Right alignment      8) Grow font

9) Shrink font   10) Line spacing

V Identify the following text effect

1) Underline  2) Superscript 3) Bold, font color   4)Uppercase  

5) Text highlight  6) Italic  7) Strikethrough 

VI Choose the correct answer

1) Adding new text    2) Strikethrough    3) Center align     4) Justify align      5) Left align

VII Match the following

VIII Answer the following

1) To change the case of the existing text without retyping it by using change case option.  

    To change the text case click the change case button from font group, and then click any 

    change case you want.

2) Alignment means arranging words or documents in a more structured way. MS Word 

                provides four options to align text: Left, Right, Center and Justify.
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ITG-IV 2 MS WORD - EDITING FEATURES

III Fill in the blanks 

1) 

2) Task bar 3) Windows Keys +S     4) Task View       5) Cortana

IV Match the following

V Choose the correct answer

1) Personalize options      2) 3)          5) Win Key +C 6) 

VI Answer the following questions

1) Operating system software is a key part of all computers. It acts as a mediator 

    between the user and computer.

2) Click start button from start menu another way to open start menu is pressing the 

    windows key on the keyboard.

3) It is a voice activated personal digital assistant.

VII Match the tools and usages

1) Cortana  2) Task View  3) Open search box  4) Shut down    5) Screenshot

I Fill in the blanks

1) Editing     2) Keyboard 3) Enter key  4) Spacebar  5) Shift key 6) Tab key

II Choose the correct option

1) Delete 2) Caps lock key 3) Ctrl key 4) Copy 5) Editing

III Write what these tools do

1) Paste option      2) Cut option      3) Copy option      4) Undo     5) Redo  6) Find

IV Write the following select text using mouse with keyboard

1) Drag the mouse over the text     2) Double-click the word   3) Press and hold the Ctrl 

    key and press alphabetic key A   4)  To press and hold the Shift key and press the left 

    arrow key

V Match the following keys and its uses

1) Next stop     2) To move cursor to the next line     3) Bottom left and right corners of 

    keyboard      4) Short for Alternate key     5) To allow a single capital letter

VI Answer the following 

1) Enter Key, Delete or Backspace Key, Caps Lock Key, Shift Key, Ctrl Key, Alt Key 

2)Click on copy option on home tab or Shortcut key for copy is Ctrl+C you can also choose

.................. system software is a key part of all computers.- Operating

    copy option by right clicking on the selected text and right click on the desired area.

3) Select the text ,click on cut option on Home Tab. You can use Ctrl+x to cut. 

4) Select the text Computer, click on Copy option on Home Tab, then click on Paste option 

    on Home Tab.

5) Find option is used to find a particular word or text from a document. Replace option  

    helps you to replace any existing word with a new document.

I Fill in the blanks

1) Formatting     2) Paragraph      3) Font group      4) Line space   5) Shrink font

6) Grow font     7) Font group     8) Align right

II Identify the alignment option

a) Align Left      b) Center      c) Align Right          d) Justify

III Write shortcut key for the following

1) Ctrl+B 2) Ctrl+I 3) Ctrl+U 4) Ctrl+J 5) Ctrl+E 6) Ctrl+R

7) Ctrl+L 8) Ctrl+A

IV Match the following icons

1) Text effect     2) Font color      3) Text highlight color  4) Strikethrough

5) Change case   6) Center Alignment      7) Right alignment      8) Grow font

9) Shrink font   10) Line spacing

V Identify the following text effect

1) Underline  2) Superscript 3) Bold, font color   4)Uppercase  

5) Text highlight  6) Italic  7) Strikethrough 

VI Choose the correct answer

1) Adding new text    2) Strikethrough    3) Center align     4) Justify align      5) Left align

VII Match the following

VIII Answer the following

1) To change the case of the existing text without retyping it by using change case option.  

    To change the text case click the change case button from font group, and then click any 

    change case you want.

2) Alignment means arranging words or documents in a more structured way. MS Word 

                provides four options to align text: Left, Right, Center and Justify.
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    Step 3: Click on Import button. An Import Background dialog box appears.

    Step 4: Select the required image file from the selected folder.

    Step 5: Click on OK button. The Stage background will be changed.

4) 

    also introduces the blocks that allow you either to show the Sprite on the stage or to make 

    it disappear. For this purpose use the  Show and Hide block respectively

I Fill in the blanks

1) Health Care     2) Education         3) Navigation System     4) Departmental Store

5) Transportation 6) Robot 7) Communication

II Answer in one word

1) Education,    Transportation,    Engineering Design,    Business,    Defense

2) Global positioning system     3) Yes 4) Yes         5) Automated Teller Machine

III Match the following

1) Entertainment     2) Government sector 3) Engineering Design   

4) Communication media     5) Science and Technology     6) Healthcare     7) Education

IV True or False 

 1) True     2) False      3) True      4) True      5) True      6) False   

V Find out following unscrambled words

1) Online     2) Healthcare     3) Robot     4) Defense     5) Surgery      6) Entertainment

VI Identify the following fields

1) Government sector    2) Business 3) Engineering design   4) Video Conferencing

5) Science and Technology 6) Entertainment       7) Education  8) Transportation

VII Who am I?

1) E-education 2) ATM 3) Robot 4) Mobile Banking

VIII Answer the following

1) Computer lab changed the traditional method of teaching and learning there are many

    facilities in the education field are  Computer based education, CBT, Online education

    Distant education, Online examination etc.

2) ATM Stands for Automated Teller Machine. Banks are using ATM’s for facilitating their 

    customers to withdraw their amount.

3) GPS stands for  Global positioning system. It shows a map which will track our vehicles

    movement through satellite signals.

4) Computer keeps customer records and transfer money to other accounts and can pay

     their utility bill online using computer. 

The Looks Block Palette contains various blocks that control the appearance of  Sprite. It 

ITG-IV 6 APPLICATIONS OF COMPUTER

ITG-IV 5 MORE ON SCRATCH

I Fill in the blanks

1) Slide      2) Slide pane 3) F5      4) Ctrl+M      5) Ctrl+ Shift+D      6) Slides

II State whether True or False

1) False 2) False 3) True 4) False 5) True

III Identify the following icons

1) Open 2) Start Button 3) Print 4) Save 5) New slide icon

IV Name the following

1) Title 2) Quick Access Toolbar 3) Status bar 4) File       5) Slide

V Match the following

1) To return to the previous view 2) To press the mouse button

3) To open a pop-up menu 4) To go to the next slide 5) To delete a slide

VI Multiple choice Questions

1) Press ESC     2) Slides       3) Ctrl+S            4) Ctrl+O        5) F5 6) Ctrl+O

VII Answer the following

1) A slide is a single page in a PowerPoint presentation.

2) To display a presentation by pressing slide show tab on the ribbon and click the from 

    beginning button in the start slide show group.

I Fill in the Blanks

1) Thumbnails 2) Costumes 3) Repeat 4) Graphics

5) Brightness

II Multiple Choice Questions

1)  2) Grow 3) Sprite Header Pane 4)

5) 6) Mosaic

III State whether True or False

1) False 2) False 3) True 4) False 5) True 6) False

IV Answer the Following

1)  Script Tab is active by default. When you start a new project , the Script tab is automatically selected, 

     displaying the Script area.

2)  Sprite header pane includes information about the selected Sprite as well as a few tools for manipulating 

     the Sprite. It shows a Sprite’s name x-y position and direction.

3)  Step 1: Double click on the Stage thumbnail in the Sprite List. A new screen with three tabs Scripts, 

                 Background and Sounds will appear.

     Step 2: Click on Backgrounds tab .
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    Step 3: Click on Import button. An Import Background dialog box appears.

    Step 4: Select the required image file from the selected folder.

    Step 5: Click on OK button. The Stage background will be changed.

4) 

    also introduces the blocks that allow you either to show the Sprite on the stage or to make 

    it disappear. For this purpose use the  Show and Hide block respectively

I Fill in the blanks

1) Health Care     2) Education         3) Navigation System     4) Departmental Store

5) Transportation 6) Robot 7) Communication

II Answer in one word

1) Education,    Transportation,    Engineering Design,    Business,    Defense

2) Global positioning system     3) Yes 4) Yes         5) Automated Teller Machine

III Match the following

1) Entertainment     2) Government sector 3) Engineering Design   

4) Communication media     5) Science and Technology     6) Healthcare     7) Education

IV True or False 

 1) True     2) False      3) True      4) True      5) True      6) False   

V Find out following unscrambled words

1) Online     2) Healthcare     3) Robot     4) Defense     5) Surgery      6) Entertainment

VI Identify the following fields

1) Government sector    2) Business 3) Engineering design   4) Video Conferencing

5) Science and Technology 6) Entertainment       7) Education  8) Transportation

VII Who am I?

1) E-education 2) ATM 3) Robot 4) Mobile Banking

VIII Answer the following

1) Computer lab changed the traditional method of teaching and learning there are many

    facilities in the education field are  Computer based education, CBT, Online education

    Distant education, Online examination etc.

2) ATM Stands for Automated Teller Machine. Banks are using ATM’s for facilitating their 

    customers to withdraw their amount.

3) GPS stands for  Global positioning system. It shows a map which will track our vehicles

    movement through satellite signals.

4) Computer keeps customer records and transfer money to other accounts and can pay

     their utility bill online using computer. 

The Looks Block Palette contains various blocks that control the appearance of  Sprite. It 
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I Fill in the blanks

1) Slide      2) Slide pane 3) F5      4) Ctrl+M      5) Ctrl+ Shift+D      6) Slides

II State whether True or False

1) False 2) False 3) True 4) False 5) True

III Identify the following icons

1) Open 2) Start Button 3) Print 4) Save 5) New slide icon

IV Name the following

1) Title 2) Quick Access Toolbar 3) Status bar 4) File       5) Slide

V Match the following

1) To return to the previous view 2) To press the mouse button

3) To open a pop-up menu 4) To go to the next slide 5) To delete a slide

VI Multiple choice Questions

1) Press ESC     2) Slides       3) Ctrl+S            4) Ctrl+O        5) F5 6) Ctrl+O

VII Answer the following

1) A slide is a single page in a PowerPoint presentation.

2) To display a presentation by pressing slide show tab on the ribbon and click the from 

    beginning button in the start slide show group.

I Fill in the Blanks

1) Thumbnails 2) Costumes 3) Repeat 4) Graphics

5) Brightness

II Multiple Choice Questions

1)  2) Grow 3) Sprite Header Pane 4)

5) 6) Mosaic

III State whether True or False

1) False 2) False 3) True 4) False 5) True 6) False

IV Answer the Following

1)  Script Tab is active by default. When you start a new project , the Script tab is automatically selected, 

     displaying the Script area.

2)  Sprite header pane includes information about the selected Sprite as well as a few tools for manipulating 

     the Sprite. It shows a Sprite’s name x-y position and direction.

3)  Step 1: Double click on the Stage thumbnail in the Sprite List. A new screen with three tabs Scripts, 

                 Background and Sounds will appear.

     Step 2: Click on Backgrounds tab .
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ITG-V 1 INSIDE A COMPUTER

4) Humans have brain, emotions and  developing personal connections but machines 

    capable of thinking or acting intelligent and also solve difficult problems and puzzles.

            5) Internet of Things

I Fill in the Blanks

1) Motherboard     2) RAM     3) Motherboard    4) SMPS      5) Video card    6) Modem

II Match the following

1) Secondary storage - Hard Disk 2) Power supply 3) Software

4) Digital Pathway 5) Centronics Interface

III Choose the Correct Answer

1) CPU 2) MP3 Player 3) Heat sink 4) Graphic Card

IV True or False

1) False 2) False 3) True 4) True 5) True

V Answer the following

1)Motherboard is the main circuit board which serves to connect all of  parts of a computer 

    together.

2) It helps bring cool air into and blow hot air out of the case.

3) RAM is known as Random Access Memory. It helps to store data until the machine is 

    working.

4) USB port stands for universal serial bus. It helps to connect USB devices each other  and

    to transfer digital data.

5) It allows the computer to send graphical information to a video display device such as a 

    monitor.

6) Physical parts of a computer are known as hardware. Eg. Monitor, keyboard, mouse etc.

7) Micro processor is an integrated chip which accepts digital data as input, process it and 

    provides the result as output.

8) The parallel port is  a 25 pin computer interface commonly used to connect printers  with 

    a computer. 

I Fill in the blanks

1) Operating system        2) File    3) List view    4) Folder view        5) Title view

6) File Explorer      7) Sort by      8) File     9) Recycle bin

II Multiple choice questions       

1) Run         2) Recycle Bin        3) calc       4) Move
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ITG-IV 7 HISTORY OF ARTIFICIAL INTELLIGENCE

5) Computer have helped Doctors and administrative staff are using computers to mange 

    patient history and stock of medicine etc. some other fields are lab diagnose, patient 

    monitoring, pharma  information and also use in surgery.

6) CBT stands for computer based training. It is a low cost solution for educating many 

    skills to a large number of people in lesser time at their own place.

IX Crosswords ( Computer used in different fields)

A1) Defense A2) Space research A3) Robot A4) Marketing

D1) Online D2) Health Care D3) Entertainment D4) Record

I Fill in the blanks

            1) Virtual assistant device.     2) Artificial Intelligence     3) Artificial Intelligence 

            4) John McCarthy  5) Internet of Things

II State whether True or False     

1) True  2) True  3) True  4) False

III Match the following   

1) Alexa 2) Self-Driving 3) Urban Area  4) Internet of Things

IV Identify the following image

            Siri             Microsoft's Cortana              Amazon Alexa             Google Assistant           

V         Multiple Choice Questions

            1. Siri   2.Autonomous     3. John McCarthy    4. Smart Home     5.Smart City       6.Alexa

VI        Find the words in the given grid

VII Answer the following

            1)  Artificial Intelligence can be defined as a branch of computer science that can simulate 

    human intelligence.

2) The ways we communicate with our machines, and the ways our machines communicate 

   with us like Siri on your iPhone, Google Assistant functioning on various mobile and 

    smart home devices, Amazon Alexa used in Amazon Echo or Microsoft's Cortana.

3) Self-driving vehicles are cars or trucks in which human drivers are not required to take 

    control to operate the vehicle safely.

ITG-V 2 WINDOWS 10

22 23



ITG-V 1 INSIDE A COMPUTER

4) Humans have brain, emotions and  developing personal connections but machines 

    capable of thinking or acting intelligent and also solve difficult problems and puzzles.

            5) Internet of Things

I Fill in the Blanks

1) Motherboard     2) RAM     3) Motherboard    4) SMPS      5) Video card    6) Modem

II Match the following

1) Secondary storage - Hard Disk 2) Power supply 3) Software

4) Digital Pathway 5) Centronics Interface

III Choose the Correct Answer

1) CPU 2) MP3 Player 3) Heat sink 4) Graphic Card

IV True or False

1) False 2) False 3) True 4) True 5) True

V Answer the following

1)Motherboard is the main circuit board which serves to connect all of  parts of a computer 

    together.

2) It helps bring cool air into and blow hot air out of the case.

3) RAM is known as Random Access Memory. It helps to store data until the machine is 

    working.

4) USB port stands for universal serial bus. It helps to connect USB devices each other  and

    to transfer digital data.

5) It allows the computer to send graphical information to a video display device such as a 

    monitor.

6) Physical parts of a computer are known as hardware. Eg. Monitor, keyboard, mouse etc.

7) Micro processor is an integrated chip which accepts digital data as input, process it and 

    provides the result as output.

8) The parallel port is  a 25 pin computer interface commonly used to connect printers  with 

    a computer. 

I Fill in the blanks

1) Operating system        2) File    3) List view    4) Folder view        5) Title view

6) File Explorer      7) Sort by      8) File     9) Recycle bin

II Multiple choice questions       

1) Run         2) Recycle Bin        3) calc       4) Move
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ITG-IV 7 HISTORY OF ARTIFICIAL INTELLIGENCE

5) Computer have helped Doctors and administrative staff are using computers to mange 

    patient history and stock of medicine etc. some other fields are lab diagnose, patient 

    monitoring, pharma  information and also use in surgery.

6) CBT stands for computer based training. It is a low cost solution for educating many 

    skills to a large number of people in lesser time at their own place.

IX Crosswords ( Computer used in different fields)

A1) Defense A2) Space research A3) Robot A4) Marketing

D1) Online D2) Health Care D3) Entertainment D4) Record

I Fill in the blanks

            1) Virtual assistant device.     2) Artificial Intelligence     3) Artificial Intelligence 

            4) John McCarthy  5) Internet of Things

II State whether True or False     

1) True  2) True  3) True  4) False

III Match the following   

1) Alexa 2) Self-Driving 3) Urban Area  4) Internet of Things

IV Identify the following image

            Siri             Microsoft's Cortana              Amazon Alexa             Google Assistant           

V         Multiple Choice Questions

            1. Siri   2.Autonomous     3. John McCarthy    4. Smart Home     5.Smart City       6.Alexa

VI        Find the words in the given grid

VII Answer the following

            1)  Artificial Intelligence can be defined as a branch of computer science that can simulate 

    human intelligence.

2) The ways we communicate with our machines, and the ways our machines communicate 

   with us like Siri on your iPhone, Google Assistant functioning on various mobile and 

    smart home devices, Amazon Alexa used in Amazon Echo or Microsoft's Cortana.

3) Self-driving vehicles are cars or trucks in which human drivers are not required to take 

    control to operate the vehicle safely.
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    organizations etc

2) Microsoft Edge is a web browsing software for using internet. It is a part of Microsoft 

    Windows 10 operating system.

3) It is a collection of Inter-connected pages that contains text, pictures, audio and movies.

    Its contains millions of websites with interlinked documents of information. A website

    name begins with www.

4) Electronic mail or e-mail is the most popular feature of the internet. It is used to send 

    document, pictures and videos. It is very fast, easy and economical media for sending or  

    receiving messages around the world.

5) Search engine is a computer program used to search information on web. Search  engine 

    helps us to search website, images audio and videos. It is also used to find information 

    about people, places, business, organizations, institutions etc.

6) Web browser is an application software used to open websites. It helps you to view Web 

    pages containing information, documents, images, audio and videos, animation movies

   etc. Some popular web browsers are: Internet Explorer, Google Chrome, Mozillla Firefox

V Identify these Keys

1) Attach File       2) Notification      3) Delete button   4) Refresh        5) Search

I Fill in the blanks

1) Shapes 2) Adjust group 3) Wrap text 4) Add-ins 

5) Adjust group 6) Flip Horizontal 7) Symbol 8) Internet 

II Multiple choice questions

1) Illustrations 2) 72 3) WordArt 4) Media

III Match the following

1) Illustrations 2) Text 3) Adjust 4) Arrange 5) Rotate

IV True or False

1) False 2) True 3) False 4) True 5) False

V Answer the following

1)WordArt is a gallery of text styles that can be add to Microsoft Office 2016 documents to 

    create decorative effects to the text.

2) Picture, Online Picture, Shapes, SmartArt, Chart, Screenshot.

3) Text fill, Text outline and Text effects.

4) Word makes Symbolavailable with in the Symbol drop down list in the Symbol Group in 

    insert tab. If you click on More Symbols in drop down list you will get a Symbol window. 

5) If you want to rotate or flip the selected object, click down arrow of rotate from Arrange 

    group. Select desired option from the drop down list. You can also rotate an object to any

III State whether True or False

1) F 2) F 3) F 4) F 5) T

IV Identify the following

V Match the following

1) calc      2) OSK      3) Write      4) Winword      5) cmd      6) explorer

VI Name the following icons

VII Answer the following

1) The default style of a folder is a yellow box. These steps to change the style of a folder 

    from the folder properties window.

    * Right click on the folder you want to change.    

    * Select properties from the pop-up menu.

    * Select the customize tab .  

    * Click on the change icon button from the bottom of window.  

    * Select a picture or browse from the window to change the folder style.  

    * Click OK button.

2) Extra large icons, Large Icon, Medium icon, Small icons are the options to view folder.

3) To copy a folder click on the file explorer button on the taskbar select the folder and 

                click on copy button on home tab and display destination folder and press paste button.

4) To rename a folder click on the file explorer button on the taskbar. Select folder you want 

    to rename. Click on rename button on home tab. Type new name and press Enter  key.

5) You need to  right click on the start button to get the run option.

6) Folder is a directory which contains files and folders. A file is a collection of data stored 

    as unit and identified by a file name.

I Match the following

1) BSNL    2) Gmail.com    3) Google     4) Web browser     5) Website     6) ARPANET

II Fill in the blanks

1) E-mail    2) URL    3) Internet    4) Search engine     5) Home page    6) Social Media

III State True or False

1) True       2) True 3) False      4) False     5) True      6) True 7) False      8) True

IV Answer the following

1) It is a collection of web pages. It provides information about persons, business, Institutes

Details View Folder Recycle Bin Large Icon

1 6 7 3 5 2 4
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     a slide, follow the given steps: Select the slide that you want to duplicate. On the Home 

    tab, click on the down arrow of the new slides in the slides group. Select duplicate slides 

    from the drop down list. The duplicated slide is inserted directly below the selected slide.

7) Click the Start menu then select the PowerPoint 2016.

8) To insert new slides, follow the steps: Click on the arrow of New slide on Slides group. 

    Here, you can see different layouts like title, title and content, comparison, Blank etc. 

    click on any layout you prefer. A new slide with the selected layout will be inserted.

I Multiple choice question

1) Spreadsheet          2) Cell        3) Tabular        4) Merge          5) File

II Fill in the blanks

1) MS Excel 2) Quickly and Easily  3) Blank  4) Home tab   5) A cell  6) Worksheet

III True or False

1) False 2) True 3) True 4) False 5) True

IV Match the following

1) To go First row     2) To go Last row     3) To go Last column     4) To go First column

V Answer the following

1)MS excel carry out complex arithmetic calculation and logical operations such as 

    addition, multiplication, subtractions etc. It helps to easily generate reports and prepare 

    graphs.

2) Select the sheet, then Select Background option on the Page Setup group in Page Layout 

    tab. Select a picture and click on Insert button.

3) Merging cells means combining two or more adjacent cells into one cell.

4) To change the row height, select entire row and right click on it. Select Row Height 

    option from the popup menu. Enter a new size of row in the Row height box and click on 

    OK button. You can also change the Row height by the directional arrow tool at the row 

    heading margin.

5) There are 1048576 rows and 16384 columns in a worksheet.

6) Click on the new option from the file tab. Then, select new blank workbook.

7) Select close option from the File tab.

I Fill in the Blanks

1) Pen     2) 480 and 360 3)Background    4) 0(Zero)

5) Sprite     6) Sprite Header Pane 7) 240 and 180    8) Flag

ITG-V 5 MICROSOFT POWERPOINT 2016

    angle with the help of the rotation handles (Round arrow that appears at the top of  an

    selected shape).

6) Click on the Picture in the illustration group on the insert tab. Then select a picture that 

   you want to insert from the insert picture window. Click on insert or double click on the 

    picture.
0 0.

7) Horizontal, Rotate all text 90  and  Rotate all text 270

8) Click on Online pictures on Illustrations group on Insert tab. In search box, type the word 

    that you want to search for an image and select an item and click on insert option.

I Fill in the blanks

1) Power point 2) Home tab 3) Slides group4) Home tab

5) Drawing group 6) Slide 7) Shape outline button

II True or False

1)  False 2)  False 3) False 4) True 5) True

III Match the following

1) Different Layout 2) Reflection 3) Bring to front 4) Drawing group

IV Fill the following steps

1) Insert a new slide: Click new slide in slide group, you can see Different layouts, Select 

    one layout.

2) To duplicate a slide: Select one slide, click new slide in slide group, select Duplicate slide 

    from drop down.

3) To insert a shape: Click on Shape box in Drawing group, select a shape from drop down 

    list, Drag the mouse where you want to insert shape on the slide.

IV Fill the crossword

1) Delete 2) Quick style 3) Drawing 4) Slides 5) Font

V Answer the following

1) A Presentation is a collection of slides. Slides are individual pages that consist of titles, 

     texts, graphics, clipart, videos, sounds, etc.

2) Clipboard, Slides, Font, Paragraph, Drawing, Editing.

3) Slide is an individual page of a presentation. It is the actual area where you can make a 

    presentation. It is used to arrange the objects of a presentation.       

4) To enter or edit the texts click on the text box in the slides.

5) You can fill the selected shape with  gradient, follow the steps:

    Select the shape that you want to fill.     Click shape fill on the Drawing group.     Select 

    the gradient option from the drop down list and select one gradient item.

6)You can duplicate a slide with content of an existing slide in a presentation. To duplicate 
26 27
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    selected shape).

6) Click on the Picture in the illustration group on the insert tab. Then select a picture that 

   you want to insert from the insert picture window. Click on insert or double click on the 

    picture.
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8) Click on Online pictures on Illustrations group on Insert tab. In search box, type the word 

    that you want to search for an image and select an item and click on insert option.
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5) Drawing group 6) Slide 7) Shape outline button

II True or False

1)  False 2)  False 3) False 4) True 5) True

III Match the following

1) Different Layout 2) Reflection 3) Bring to front 4) Drawing group

IV Fill the following steps

1) Insert a new slide: Click new slide in slide group, you can see Different layouts, Select 

    one layout.

2) To duplicate a slide: Select one slide, click new slide in slide group, select Duplicate slide 

    from drop down.

3) To insert a shape: Click on Shape box in Drawing group, select a shape from drop down 

    list, Drag the mouse where you want to insert shape on the slide.

IV Fill the crossword

1) Delete 2) Quick style 3) Drawing 4) Slides 5) Font

V Answer the following

1) A Presentation is a collection of slides. Slides are individual pages that consist of titles, 

     texts, graphics, clipart, videos, sounds, etc.

2) Clipboard, Slides, Font, Paragraph, Drawing, Editing.

3) Slide is an individual page of a presentation. It is the actual area where you can make a 

    presentation. It is used to arrange the objects of a presentation.       

4) To enter or edit the texts click on the text box in the slides.

5) You can fill the selected shape with  gradient, follow the steps:

    Select the shape that you want to fill.     Click shape fill on the Drawing group.     Select 
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IV Write name of the picture and year of Invention

            1.Siri, 2011         2.Asimo, 2000         3.Roomba, 2002         4. Kismet, 1990  

5.Google Home, 2016         6.Sophia, 2016

V Answer the following

1. Artificial Intelligence (AI) is a wide ranging branch of computer science, concerned with  

    building smart machines and programs, capable of performing tasks that typically

     require human intelligence.

 2. Write a short note on Alexa.

    ans: Alexa is the name of Amazon's personal digital assistant, which lets you use 

    voice commands to control a compatible device for features like streaming music, 

    news reports or even to turn on your smart lights.

3. ASIMO (Advanced Step in Innovative Mobility) is an artificial humanoid robot created 

    by  Honda in 2000. It is displayed in the Miraikan museum in Tokyo.

4.Spirit and Opportunity.                     
5.Sophia is a realistic humanoid robot capable of displaying human-like expressions and

                interacting with people.

6.Kinect for Xbox 360 is the first gaming device to track human body movement, using just 

    a 3D camera and infra-red detection, enabling users to play their  Xbox 360 wirelessly.

I Match the following

1) Wall          2) Chat App     3) 140 characters     4) Weblog       5) Video call

II Identify the logos

1) Instagram 2) Facebook 3) Hangout 4) WhatsApp

5) Twitter 6) skype 7) LinkedIn 8) Snapchat

III Find out odd one

1) Twitter 2) Blog 3) Twitter

IV Fill in the Blanks

1) Email  2) Mark Zuckerberg   3) Instant Messengers  4) 2009 

5) Video calling 6) Blog

V True or False

1) True 2) False 3) True 4)  False 5) True 6) True

VI Write the answer to the following questions

1) Email stands for electronic mail. Send and receive a letter through Internet are main 

    advantage of Email.

II State True or False 

1) True        2) False 3) True 4) False     5) True

III Match the Following

a)                    b) c)  d)

IV Multiple Choice Questions

1) X 2) Vertical 3) White 4)

VI Answer the Following

 1) You can choose more than one background in a Scratch Project. All the backgrounds, 

    displayed in background list available under Backgrounds tab. To add a new background,

    click on the stage icon and click Import button from Background tab. Select any new 

    background from the Import folder.

2) Pen block instructions are used to draw a trail as the Sprite moves on the stage. Each pen 

    colour has different shades that vary from the lightest to the darkest. The pen shade varies 

    from 0 to 100. 0 is the darkest and 100 is the lightest shade.

3) There are three buttons in rotation style: Can rotate, Only face left- right and don’t rotate.

4) To add a new sprite on the stage, open the scratch window. Remove the cat sprite  by right 

    clicking on it and selecting the delete option. Click on the Choose new sprite from file 

    button. Select a new sprite from the folder in the new sprite dialog box.

5) A sprite can also be made to glide on the stage to a specific location. You have to specify 

    the x and y location and the number of second using in the “glide secs to x:  y:” block .

6) The Position of a Sprite can be set on the stage. The scratch stage is divided into x-y 

    coordinates. At any time while creating the project, if you want to know exact location of 

    the Sprite, you can select the check boxes of x position, y position and direction present at 

    the end of the Motion block palette. The sprite’s  x:  y:  location and the direction will be 

    displayed on the stage. The Scratch stage is 480 pixels wide and 360 pixels high. Each 

    point on the stage is represented by two numbers. These numbers are called X and  Y 

    values. The middle of the stage has X coordinate of 0 and Y coordinate of 0. The X value 

    determines the horizontal location of the Sprite and the Y value determines the vertical 

    location or height.

I Multiple choice question

            1.     2.          3. Kismet  4. Google      5. Cortana

II Write T for True and F for False         

 1. F     2. F        3. F      4. F          5.T

III Match the following    

 1.Cortana        2.Google Assistant          3.Siri 4.Alexa

John McCarthy Siri
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6) The Position of a Sprite can be set on the stage. The scratch stage is divided into x-y 

    coordinates. At any time while creating the project, if you want to know exact location of 
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    the end of the Motion block palette. The sprite’s  x:  y:  location and the direction will be 

    displayed on the stage. The Scratch stage is 480 pixels wide and 360 pixels high. Each 
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       Microsoft Edge in it.

(d) Open it by search box. Type edge in search box on the taskbar, and hit Microsoft Edge in 

    the result.

3) Windows Store helps to browse many apps in windows 10 and to download free apps on 

    your system.

4) You can install apps in windows10, select windows store enter the name into the search 

    box in the upper- right corner of the store. Then click on free button to instal free apps.

5) The easiest way to uninstall windows 10 app is to type the name of the app in the taskbar 

    search. Once its icon is displayed in the search result, right-click on it and select uninstall.

6) To change the default look and feel of the desktop by pressing right click mouse button 

    on the blank area of desktop select the personalize option, then click on the background 

    tab to choose solid, colour or slide show to change the appearance.

7) Suppose, you want to make a shortcut key to open excel app easily access a program by

    keyboard, following the steps to make shortcut key.

    Right click on the Excel icon and select Properties.

    Enter a key combination in the Shortcut key field.

    The combination must be CTRL+ALT+ Shift a letter/num. Here we used the function 

    key (F7). Click on the OK button

8) You can disable Snap Assist by simply toggling the arrange windows automatically by 

    dragging them to the sides or corners of the screen option Off: Click on Start> Setting>    

    System> Multitasking> Snap.

9) Cloud computing means storing and accessing data and programs over the internet 

    instead of your computer’s hard drive. They are safer and more accessible place for 

    companies  to store data than traditional computing methods. An example of a Cloud 

    Computing provider is Google’s Gmail.  

I Fill in the blanks

1) Grow Font 2) Ascending or Descending  3) Clear formatting

4) Text   5) Column formatting

II Multiple choice question

1) Spelling error 2) Esc 3) Indent 4) Shrink font 5) Insert

III Identify the shortcuts

1) Shrink font       2) Clear formatting     3) Superscript      4) Grow font    5) Change Case

IV Match the following

1) Home tab      2) Review tab    3) Layout tab     4) Insert      5) Save As- File

2) Message, information, image, etc posted on twitter is called tweet.

3) The blog in the short term of the word weblog. It is a part of website with content written 

    frequently and added in a chronological order.

4) Brain Acton and Jan Koum are the founders of Whatsapp.

5) It is a technology that integrates telephone service with computer networks.

6) The advantage of Social media are, they are active and are working together for social 

    justice. they build lot of stars due to their individual performance. Politicians use them to 

    convey their messages. Companies are using them to search candidate profile and 

    previous history.  

I Fill in the blanks

1) Internal 2) Microsoft Edge 3) Action Center 4) Windows Store

5) Personalization Settings 6) Lock 7) Snap Assist

8) Gmail 9) Burn 10) Windows

II Multiple choice questions

1) Share        2)Internet        3) Maps       4) Internet Explorer        5) Personalization

III State whether True or False

1) True 2) True 3) False 4) True

IV Name the following icons

1) Share 2) Windows store 3) Microsoft Edge 4) Personalization Settings

5) Maps 6) Media Player

V Match the following

1) To find landmarks 2) To transfer file over a network

3) To arrange windows screen 4) + 5) Settings of background, Color, etc.

VI Identify the windows

1) Burn CD or DVD 2) Color 3) Action Center

VII Answer the following

1) Share file are photos, documents and videos in windows 10. Files and folders can be 

    shared with other users of your computer,or other devices on your network.

2) There are four ways to open Microsoft edge. to access it, you can choose any of the 

    following methods. (a) Access the browser form start menu [Right pane]. Or open start 

    menu, and then choose Microsoft edge in it.

    (b) Open it via its icon on the taskbar. Click the Edge icon on the taskbar.

    (c) Access the browser from the start menu [Left pane]. Open start menu, choose    
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       Microsoft Edge in it.

(d) Open it by search box. Type edge in search box on the taskbar, and hit Microsoft Edge in 

    the result.

3) Windows Store helps to browse many apps in windows 10 and to download free apps on 

    your system.

4) You can install apps in windows10, select windows store enter the name into the search 

    box in the upper- right corner of the store. Then click on free button to instal free apps.

5) The easiest way to uninstall windows 10 app is to type the name of the app in the taskbar 

    search. Once its icon is displayed in the search result, right-click on it and select uninstall.

6) To change the default look and feel of the desktop by pressing right click mouse button 

    on the blank area of desktop select the personalize option, then click on the background 

    tab to choose solid, colour or slide show to change the appearance.

7) Suppose, you want to make a shortcut key to open excel app easily access a program by

    keyboard, following the steps to make shortcut key.

    Right click on the Excel icon and select Properties.

    Enter a key combination in the Shortcut key field.

    The combination must be CTRL+ALT+ Shift a letter/num. Here we used the function 

    key (F7). Click on the OK button

8) You can disable Snap Assist by simply toggling the arrange windows automatically by 

    dragging them to the sides or corners of the screen option Off: Click on Start> Setting>    

    System> Multitasking> Snap.

9) Cloud computing means storing and accessing data and programs over the internet 

    instead of your computer’s hard drive. They are safer and more accessible place for 

    companies  to store data than traditional computing methods. An example of a Cloud 

    Computing provider is Google’s Gmail.  

I Fill in the blanks

1) Grow Font 2) Ascending or Descending  3) Clear formatting

4) Text   5) Column formatting

II Multiple choice question

1) Spelling error 2) Esc 3) Indent 4) Shrink font 5) Insert

III Identify the shortcuts

1) Shrink font       2) Clear formatting     3) Superscript      4) Grow font    5) Change Case

IV Match the following

1) Home tab      2) Review tab    3) Layout tab     4) Insert      5) Save As- File

2) Message, information, image, etc posted on twitter is called tweet.

3) The blog in the short term of the word weblog. It is a part of website with content written 

    frequently and added in a chronological order.

4) Brain Acton and Jan Koum are the founders of Whatsapp.

5) It is a technology that integrates telephone service with computer networks.

6) The advantage of Social media are, they are active and are working together for social 

    justice. they build lot of stars due to their individual performance. Politicians use them to 

    convey their messages. Companies are using them to search candidate profile and 

    previous history.  

I Fill in the blanks

1) Internal 2) Microsoft Edge 3) Action Center 4) Windows Store

5) Personalization Settings 6) Lock 7) Snap Assist

8) Gmail 9) Burn 10) Windows

II Multiple choice questions

1) Share        2)Internet        3) Maps       4) Internet Explorer        5) Personalization

III State whether True or False

1) True 2) True 3) False 4) True

IV Name the following icons

1) Share 2) Windows store 3) Microsoft Edge 4) Personalization Settings

5) Maps 6) Media Player

V Match the following

1) To find landmarks 2) To transfer file over a network

3) To arrange windows screen 4) + 5) Settings of background, Color, etc.

VI Identify the windows

1) Burn CD or DVD 2) Color 3) Action Center

VII Answer the following

1) Share file are photos, documents and videos in windows 10. Files and folders can be 

    shared with other users of your computer,or other devices on your network.

2) There are four ways to open Microsoft edge. to access it, you can choose any of the 

    following methods. (a) Access the browser form start menu [Right pane]. Or open start 

    menu, and then choose Microsoft edge in it.

    (b) Open it via its icon on the taskbar. Click the Edge icon on the taskbar.

    (c) Access the browser from the start menu [Left pane]. Open start menu, choose    
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       effects in drop list. Click on the split animation effect - Select vertical option in open from 

    animation pane- Select applause from sound box- Select by letter from the animation text 

    then click ok button.

4) Normal view, Outline View, Slide Sorter view, Notes Page view, Reading view, Master 

    views: Slide, Handout and Notes.

5) Hide slide option is used for hiding selected slides from the presentation.

6)Outline view is used to create an outline or story board for your presentation. It 

    displays only the text on your slides, not graphical items in the thumbnail tab.

    Note Page view allows to make notes under the slide without affecting presentation in 

    Slide show.

7) Timing option from animation pane drop down list is used for deciding how the text or 

    other object should appear in a presentation. You also set the speed of your animation 

    from the duration drop down list under Timing tab.

I Choose the correct Answer 

1) MS Excel 2) Alignment 3) Normal View 4) Auto Fill

II Match the following

1) Font 2) View 3) Text Rotation 4) Sigma Sign   5) Cells group

III Fill in the blanks

1) Worksheet 2) AutoSum 3) Autofill 4) Ascending or Descending 

5) Cell orientation 6) Page layout view

IV State whether True or False

1) False 2) False 3) True 4) False 5) True

V Answer the Following

1) Font, Font size, Bold, Italic, Under line, Border, Fill color and Font color

2) Normal view,      Page Layout view,      Page Break Preview,      Custom View

3) Sorting means arranging data in ascending or descending order.

4) This option helps you to see or print a specified area in your workbook.

I Fill in the blanks

1) Graphical    2) Oval    3) Stop    4) Rectangle    5) Flow    6) Pseudocode                    

II Match the following

1) 2) Machine Language 3) Pictorial representation  4) 

5) 6) 7)
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 V State whether True or false

1) False 2) True 3) False 4) False 5) True

VI Answer the following

1) Change Case option is used to change the case of a text. It includes Uppercase,

     Lowercase, Sentence Case, Capitalise Each Word and Toggle Case.

2) Clear Formatting is used to clear all formatting text and return to its default formatting 

    style.

3) Click on Footer drop down arrow on Header and Footer group in Insert tab. Select a 

    Footer option from the drop down list. Now footer is inserted at bottom of the document.

4) Sort option is used to arrange texts in ascending or descending order. This feature can be 

    particularly helpful for sorting bibliographies, glossary entries, list of names etc.

5) Multilevel list option means to add bullets or numbers for sub items in a list.

6) Drop cap option is used to create a large dropped initial capital letter on the beginning of 

    a paragraph.

7) Click on Page Number option from the drop down list on the Header and Footer group in 

    the Insert tab.  select a page number option from the drop down list. Then, page number is 

    inserted in the document.

I Name the group

1) Master view 2) Advanced animation group 3) Setup group

II Fill in the blanks

1) Animation     2) Slide sorter     3) Normal view     4) Pointer option     5) Outline view

III Multiple choice question

1) Custom slide show    2) Pointer option 3) F5 4) Ctrl+A  5) Notes page

IV True or False

1) False 2) True 3) False 4) False 5) False

V Match the following

1) Start Slide Show     2) Master View     3) Presentation Views    4) Animation    5) Slides

VI Answer the following

1) While showing your PowerPoint slide show, you can use both keyboard and the mouse to 

    control your presentation. You can control by right clicking on the screen and selecting 

    relevant option from the popup menu. Next, previous,  see all slides, Pointer option and 

    End Show  are the important slide show control options.

2) This is an animation effect used to move an object or text in a specified path.

3) Text can be animate in different ways in the presentation. Select text, from animation tab, 

    click on the more button in animation group. Then you see various type of animation
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       effects in drop list. Click on the split animation effect - Select vertical option in open from 

    animation pane- Select applause from sound box- Select by letter from the animation text 

    then click ok button.

4) Normal view, Outline View, Slide Sorter view, Notes Page view, Reading view, Master 

    views: Slide, Handout and Notes.

5) Hide slide option is used for hiding selected slides from the presentation.

6)Outline view is used to create an outline or story board for your presentation. It 

    displays only the text on your slides, not graphical items in the thumbnail tab.

    Note Page view allows to make notes under the slide without affecting presentation in 

    Slide show.

7) Timing option from animation pane drop down list is used for deciding how the text or 

    other object should appear in a presentation. You also set the speed of your animation 

    from the duration drop down list under Timing tab.

I Choose the correct Answer 

1) MS Excel 2) Alignment 3) Normal View 4) Auto Fill

II Match the following

1) Font 2) View 3) Text Rotation 4) Sigma Sign   5) Cells group

III Fill in the blanks

1) Worksheet 2) AutoSum 3) Autofill 4) Ascending or Descending 

5) Cell orientation 6) Page layout view

IV State whether True or False

1) False 2) False 3) True 4) False 5) True

V Answer the Following

1) Font, Font size, Bold, Italic, Under line, Border, Fill color and Font color

2) Normal view,      Page Layout view,      Page Break Preview,      Custom View

3) Sorting means arranging data in ascending or descending order.

4) This option helps you to see or print a specified area in your workbook.

I Fill in the blanks

1) Graphical    2) Oval    3) Stop    4) Rectangle    5) Flow    6) Pseudocode                    

II Match the following

1) 2) Machine Language 3) Pictorial representation  4) 

5) 6) 7)
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 V State whether True or false

1) False 2) True 3) False 4) False 5) True

VI Answer the following

1) Change Case option is used to change the case of a text. It includes Uppercase,

     Lowercase, Sentence Case, Capitalise Each Word and Toggle Case.

2) Clear Formatting is used to clear all formatting text and return to its default formatting 

    style.

3) Click on Footer drop down arrow on Header and Footer group in Insert tab. Select a 

    Footer option from the drop down list. Now footer is inserted at bottom of the document.

4) Sort option is used to arrange texts in ascending or descending order. This feature can be 

    particularly helpful for sorting bibliographies, glossary entries, list of names etc.

5) Multilevel list option means to add bullets or numbers for sub items in a list.

6) Drop cap option is used to create a large dropped initial capital letter on the beginning of 

    a paragraph.

7) Click on Page Number option from the drop down list on the Header and Footer group in 

    the Insert tab.  select a page number option from the drop down list. Then, page number is 

    inserted in the document.

I Name the group

1) Master view 2) Advanced animation group 3) Setup group

II Fill in the blanks

1) Animation     2) Slide sorter     3) Normal view     4) Pointer option     5) Outline view

III Multiple choice question

1) Custom slide show    2) Pointer option 3) F5 4) Ctrl+A  5) Notes page

IV True or False

1) False 2) True 3) False 4) False 5) False

V Match the following

1) Start Slide Show     2) Master View     3) Presentation Views    4) Animation    5) Slides

VI Answer the following

1) While showing your PowerPoint slide show, you can use both keyboard and the mouse to 

    control your presentation. You can control by right clicking on the screen and selecting 

    relevant option from the popup menu. Next, previous,  see all slides, Pointer option and 

    End Show  are the important slide show control options.

2) This is an animation effect used to move an object or text in a specified path.

3) Text can be animate in different ways in the presentation. Select text, from animation tab, 

    click on the more button in animation group. Then you see various type of animation
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III Multiple Choice Questions

 1) a    2) c    3) a

IV Match the Following

1)Love drawing and painting    2) Fast problem solving    3) Thoughts about human

    existence   4) Likes singing   5) Enjoy gardening

V Answer the Following

1) Intelligence refers to the ability to think, to learn from previous experience, to solve

    complex problems and to adapt new things and environment.

            2) Logical-Mathematical Intelligence people possess the following characteristics. They 

    are analyzing problems. Analyzing mathematical operation, fast problem solving, Likes 

    thinking about abstract ideas, love conducting scientific experiments and solve complex 

    computations easily.

3) Naturalistic Intelligence people have good relationship with nature. They enjoying

    activities like camping, gardening, hiking and exploring outdoors. They are also interest 

    in exploring the environment and learning about other species.

4) A rule-based system uses rules as knowledge representation. These rules are coded in the 

    system in the form of if-then-else statements which help computer in taking decisions. A 

    computer  that achieves AI through a machine learning technique is called a learning-

    based approach. This type of approach facilitates acquisition of new knowledge.

5) Intra-personal Intelligence people posses strength in introspection and self reflection. 

    Understanding ones own strengths and weaknesses. Enjoys analysing theories and ideas.

I Fill in the blanks

1) GPS   2) Home page    3) Layout 4) View in different angles      5) Show Imagery

II Match the following

1) Street view 2) Popular online encyclopedia 3) Sky view

4) Current location determiner 5) Bottom part of a website

III Arrange the order of map searching to know distance between two places

(1) C (2) B  (3) D (4) A  (5) E  

IV Choose the answer

1) Header 2) Flipkart 3) Layout 4) Cash on Delivery

V Tick logo related with E-commerce
8

III State whether True or False

1) True 2) True 3) True 4) True 5) False

IV Multiple choice question

1) b       2) c       3) a        4) c       5) c       6) c    

V Answer the following questions

1) A flowchart is a step by process to solve a problem in a pictorial from.

2) Oval - Start/ Stop box is used to represent starting and ending of a flowchart

    Parallelogram- Input/ Output box is used to read and print any data.

    Rectangle- Processing box is used for calculation.

3) An algorithm is a step-by-step process of solving any problem. It is the first step of 

    developing  program.

4) A program is a set of instructions that makes the computer work. There are some  

    common high- level languages are BASIC, QBASIC, LOGO, C, C++, JAVA etc

I Fill in the blanks 

1) Compiler    2) .py 3) Ctrl+D, Ctrl+Q or type quit()  4) >>>

II State whether True or False

1)  True        2)   False          3)  False 4) True 5)  False

III Answer the Following

1) Python is a high level, general purpose programming language created by Guido 

Van Rossum. It was publicly released in 1991.

2)   What is Keyword?

3)   •   Python is easy to learn  

      •   Python portable/ platform independent

•  Python is an interpreted language

• Large standard libraries to solve common tasks etc..

4) Compiler, translates the source code to machine language.

5) To execute the python script by choosing Run option or press Ctrl +F5.

I Fill in the Blanks

1) Machines      2) Psychologist       3) Musical    4) Nature     5) Machine       6) AI

II State whether  True or False  

 1) True  2) True  3) False  4) True  5) True  6) False

      ans: Keywords are word which have fixed meaning and these meaning cannot be 

      changed. There are 33 keywords in python.
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III Multiple Choice Questions

 1) a    2) c    3) a

IV Match the Following

1)Love drawing and painting    2) Fast problem solving    3) Thoughts about human

    existence   4) Likes singing   5) Enjoy gardening

V Answer the Following

1) Intelligence refers to the ability to think, to learn from previous experience, to solve

    complex problems and to adapt new things and environment.

            2) Logical-Mathematical Intelligence people possess the following characteristics. They 

    are analyzing problems. Analyzing mathematical operation, fast problem solving, Likes 

    thinking about abstract ideas, love conducting scientific experiments and solve complex 

    computations easily.

3) Naturalistic Intelligence people have good relationship with nature. They enjoying

    activities like camping, gardening, hiking and exploring outdoors. They are also interest 

    in exploring the environment and learning about other species.

4) A rule-based system uses rules as knowledge representation. These rules are coded in the 

    system in the form of if-then-else statements which help computer in taking decisions. A 

    computer  that achieves AI through a machine learning technique is called a learning-

    based approach. This type of approach facilitates acquisition of new knowledge.

5) Intra-personal Intelligence people posses strength in introspection and self reflection. 

    Understanding ones own strengths and weaknesses. Enjoys analysing theories and ideas.

I Fill in the blanks

1) GPS   2) Home page    3) Layout 4) View in different angles      5) Show Imagery

II Match the following

1) Street view 2) Popular online encyclopedia 3) Sky view

4) Current location determiner 5) Bottom part of a website

III Arrange the order of map searching to know distance between two places

(1) C (2) B  (3) D (4) A  (5) E  

IV Choose the answer

1) Header 2) Flipkart 3) Layout 4) Cash on Delivery

V Tick logo related with E-commerce
8

III State whether True or False

1) True 2) True 3) True 4) True 5) False

IV Multiple choice question

1) b       2) c       3) a        4) c       5) c       6) c    

V Answer the following questions

1) A flowchart is a step by process to solve a problem in a pictorial from.

2) Oval - Start/ Stop box is used to represent starting and ending of a flowchart

    Parallelogram- Input/ Output box is used to read and print any data.

    Rectangle- Processing box is used for calculation.

3) An algorithm is a step-by-step process of solving any problem. It is the first step of 

    developing  program.

4) A program is a set of instructions that makes the computer work. There are some  

    common high- level languages are BASIC, QBASIC, LOGO, C, C++, JAVA etc

I Fill in the blanks 

1) Compiler    2) .py 3) Ctrl+D, Ctrl+Q or type quit()  4) >>>

II State whether True or False

1)  True        2)   False          3)  False 4) True 5)  False

III Answer the Following

1) Python is a high level, general purpose programming language created by Guido 

Van Rossum. It was publicly released in 1991.

2)   What is Keyword?

3)   •   Python is easy to learn  

      •   Python portable/ platform independent

•  Python is an interpreted language

• Large standard libraries to solve common tasks etc..

4) Compiler, translates the source code to machine language.

5) To execute the python script by choosing Run option or press Ctrl +F5.

I Fill in the Blanks

1) Machines      2) Psychologist       3) Musical    4) Nature     5) Machine       6) AI

II State whether  True or False  

 1) True  2) True  3) False  4) True  5) True  6) False

      ans: Keywords are word which have fixed meaning and these meaning cannot be 

      changed. There are 33 keywords in python.
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III Match the following

1) Merge Group 2) Draw group 3) Data group 4) Borders

IV Fill in the blanks

1) Merge cell    2) Table     3) Cell    4) Split     5) Alphabetical or Numerical

V Write the steps of followings

To Insert a Row:- Click  on the cell -Click on insert option of the rows and columns group. 

To convert Text to Cell:- Select the text - Click on convert text to table option tables group 

from insert tab- select tabs- separate text- convert text to table Enter ‘number’ in the number 

of columns box and OK.

To Split Cells:- Select the Row-Click on Split cell option from merge group.- Enter 1 in 

Number of Column field and 2 in Number of Rows field and click on OK button

VI Answer the following

1) A table is an arrangement of text in the form of rows and columns. It uses for presenting 

     information, in a tabular form such as calendars, progress reports and graph  etc.

2) Inserting rows and columns, Merging cells, Aligning text in cells and tables Deleting 

    rows and columns, Splitting tale and cells, Formatting table

3) Cell Alignment is used to arrange the text in a cell more attractively. To apply cell

    alignment, select the cell and select any option from Alignment group.

4) Sort option helps us to arrange texts in Alphabetical or Numerical order.

5) We can use Shading option in Design tab is use to apply background colour to the table.

6) Select the cell and click Split Table option from the Merge group.

7)To draw borders to the table, click Draw Table option in Draw group or Borders in     

    Borders group on the Design tab. When you select Draw Table, a pen appears on mouse 

    pointer. Use this pen and draw borders.

8) Select the cell and click on the Insert Above option on Rows & Columns group. 

I Fill in the blanks

1) Workbook      2) Home tab      3) Unmerge cells      4) Column      5) Ctrl + ;

6) Ascending, Auto fill        7) Cell pointer      8) Data validation 

II Multiple choice question

1) AutoFill       2) Merging     3) Three           4) Relational      5) Data            6) Review

III State  whether True or False

1) False 2) True 3) False 4) False    5) True    6) True

IV Match the following

1) <= 2) & 3) OR 4) Paste    5) Worksheet

ITG-VII 3 TABLE IN MS WORD

VI True or false 

1) True 2) False 3) True 4) True

VII Answer the following questions 

1) Home page,  Header, Navigation bar, Content, Footer, Layout

2) Jimmy Wales and Larry Sanger are founders of Wikipedia, launched on January 15, 2001 

3) Google map is a web mapping service application and technology provided by Google, 

    that powers many web based services. It is used to find street maps, a route planner for 

    traveling by foot, car, bike or using public transport.

4) Buying or Selling of products via electronic means such as Internet or other electronic 

    services.

5) Global Positioning System

I Fill in the blanks

1) <BODY TEXT= “color”  2) Text, Image, Hyperlink, etc. 3) <TITLE>

4) <BR>     5) Web      6) Hyper Text Markup Language     

II Choose the correct answer

1) WWW     2) HTML     3) tags     4) Container tag     5) <HR>      6)<TITLE>    

III Find out the odd one

1) <PRE> 2) TEXT 3) <HR>

IV Match the following

1) Bold           2) Superscript           3) Strike           4) Subscript           5) Paragraph

V Answer the following

1) HTML is a simple scripting language to create a web page.

2) A tag is an HTML command that indicates the layout or display of whole or a part of a

    web page. It always begins with a ‘<’ (less than) sign and ends with a ‘>’(greater than) 

   sign. For example: <Body> <Head> and <H1>. Tags are two types: Container and Empty

3) Attributes are additional parameters that tell how to display HTML elements. Attribute 

    appears as an attribute name followed by an equal to (=) sign and then its value.

4) Image tag is used to insert an image to enhance the look and feel of a web page

    Syntax: <IMG SRC= “image name” ALIGN= “ value” BORDER= “value”>

I Multiple choice question

1) Row 2) Draw 3) Cell Alignment 4) ALT+Home

II State whether True or False

1) False 2) False 3) True 4) False 5) True
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III Match the following

1) Merge Group 2) Draw group 3) Data group 4) Borders

IV Fill in the blanks

1) Merge cell    2) Table     3) Cell    4) Split     5) Alphabetical or Numerical

V Write the steps of followings

To Insert a Row:- Click  on the cell -Click on insert option of the rows and columns group. 

To convert Text to Cell:- Select the text - Click on convert text to table option tables group 

from insert tab- select tabs- separate text- convert text to table Enter ‘number’ in the number 

of columns box and OK.

To Split Cells:- Select the Row-Click on Split cell option from merge group.- Enter 1 in 

Number of Column field and 2 in Number of Rows field and click on OK button

VI Answer the following

1) A table is an arrangement of text in the form of rows and columns. It uses for presenting 

     information, in a tabular form such as calendars, progress reports and graph  etc.

2) Inserting rows and columns, Merging cells, Aligning text in cells and tables Deleting 

    rows and columns, Splitting tale and cells, Formatting table

3) Cell Alignment is used to arrange the text in a cell more attractively. To apply cell

    alignment, select the cell and select any option from Alignment group.

4) Sort option helps us to arrange texts in Alphabetical or Numerical order.

5) We can use Shading option in Design tab is use to apply background colour to the table.

6) Select the cell and click Split Table option from the Merge group.

7)To draw borders to the table, click Draw Table option in Draw group or Borders in     

    Borders group on the Design tab. When you select Draw Table, a pen appears on mouse 

    pointer. Use this pen and draw borders.

8) Select the cell and click on the Insert Above option on Rows & Columns group. 

I Fill in the blanks

1) Workbook      2) Home tab      3) Unmerge cells      4) Column      5) Ctrl + ;

6) Ascending, Auto fill        7) Cell pointer      8) Data validation 

II Multiple choice question

1) AutoFill       2) Merging     3) Three           4) Relational      5) Data            6) Review

III State  whether True or False

1) False 2) True 3) False 4) False    5) True    6) True

IV Match the following

1) <= 2) & 3) OR 4) Paste    5) Worksheet
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VI True or false 

1) True 2) False 3) True 4) True

VII Answer the following questions 

1) Home page,  Header, Navigation bar, Content, Footer, Layout

2) Jimmy Wales and Larry Sanger are founders of Wikipedia, launched on January 15, 2001 

3) Google map is a web mapping service application and technology provided by Google, 

    that powers many web based services. It is used to find street maps, a route planner for 

    traveling by foot, car, bike or using public transport.

4) Buying or Selling of products via electronic means such as Internet or other electronic 

    services.

5) Global Positioning System

I Fill in the blanks

1) <BODY TEXT= “color”  2) Text, Image, Hyperlink, etc. 3) <TITLE>

4) <BR>     5) Web      6) Hyper Text Markup Language     

II Choose the correct answer

1) WWW     2) HTML     3) tags     4) Container tag     5) <HR>      6)<TITLE>    

III Find out the odd one

1) <PRE> 2) TEXT 3) <HR>

IV Match the following

1) Bold           2) Superscript           3) Strike           4) Subscript           5) Paragraph

V Answer the following

1) HTML is a simple scripting language to create a web page.

2) A tag is an HTML command that indicates the layout or display of whole or a part of a

    web page. It always begins with a ‘<’ (less than) sign and ends with a ‘>’(greater than) 

   sign. For example: <Body> <Head> and <H1>. Tags are two types: Container and Empty

3) Attributes are additional parameters that tell how to display HTML elements. Attribute 

    appears as an attribute name followed by an equal to (=) sign and then its value.

4) Image tag is used to insert an image to enhance the look and feel of a web page

    Syntax: <IMG SRC= “image name” ALIGN= “ value” BORDER= “value”>

I Multiple choice question

1) Row 2) Draw 3) Cell Alignment 4) ALT+Home

II State whether True or False

1) False 2) False 3) True 4) False 5) True
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   formulas which you specify. It helps to highlight a unique cell or range of cells, emphasise 

    unusual values, visualise data by using data bars, colour scale and icon sets.

2) Color Scale are visual guides that help us understand data distribution and variation. It 

    helps to compare the range of cells by using a gradation of two or more colours.

3) Select the cell in the table- Click on the insert tab-click on any chart option in chart group.

4) A waterfall chart is also known as an Excel bridge chart since the floating columns make 

    a so called bridge connecting the end points. Treemap this chart displays hierarchically 

    structured data.

5) Click on Conditional Formatting button and point to Data Bars. Then select relevant data 

    bars from the list then you can see the data bar increasing from one to ten numbers.

6) To clear all conditional formatting from the entire sheet, select Clear Rules from Entire 

    sheet option from the Clear Rules drop down list of Conditional Formatting.

7) Format highest / lowest values in a range of cells based on a cut off value that you specify.

8) Sunburst chart is a pie chart that shows relational data sets. The inner rings of the chart 

    relate to the outer rings. A Pareto chart contains both bars and a line graph.

I Fill in the blanks

1) Complex     2) = (equal)    3) SQRT(number)      4) Logical   

5) Cell    6) Mathematical

II State whether True or False

1) False 2) True 3) True 4) True 5) True     6) True

III Multiple choice questions

1) Max()   2) MIN   

3) Which function returns result of a number raised to power-POWER      4) COUNTIF

IV Match the following

1) Number of cells within a range. 2) Add values in a specified criteria.

3) Check more than one condition. 4) To find length of a string.

5) To find factorial of a number

V Answer the following

1) The values inside the bracket in a formula are called Arguments. It can be numbers, 

    texts, logical value, array or cell references. 

   1. Constants as arguments   2. Cell or Ranges as arguments  3. Functions as arguments

2) POWER function returns the result of a number raised to a power.

    Examples:= POWER (30,2) returns 900. 
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V Write the use of following shortcut keys

1) To select entire row   2)Navigation sheet upward   3) Navigation sheet downward

4) To insert time   5) To insert current date

VI Answer the following

1) To select a single column, click on the column heading at the top of the column. To select 

    a single row, click on the row heading.

2) Merging cells means combining two or more adjacent cells into a single cell. Some other 

    merge option are: Unmerge Cells: It is used to remove merging effect.

    Merge Across: It is used to merge the cells across only. Merge & Center: It is used to 

    merge the cell with the contents aligned to center.

3) All expressions are evaluated from left to right. When two or more arithmetic operators 

  are used in an expression. B- Brackets, O- Of, DM-Division and Multiplication, AS- 

    Addition and Subtraction    

4) Auto Fill is the easiest method to fill data in cells automatically. It is used to fill a series of 

    numbers, number and text combination and dates or time periods based on a pattern. 

    Flash fill feature that fills the data in cells by picking up the pattern set.

5) (A)  G20 (B) H50

6) Text Formula, Numeric Formula, Logical Formula

7) Spreadsheet contains data and information arranged in rows and columns. It is also 

    called worksheets. A workbook is made up of one or more worksheet. Default 3 

    worksheets in  a workbook.

I Fill in the blanks

1) Data bars       2) Gridlines       3) Chart       4) Treemap chart       5) Sunbrust chart

II Multiple choice question

1) Legend 2) Waterfall    3) Design    4) Sunburst

III State whether True or False

1) False 2) True 3) True 4) True 5) False 6) True

IV Match the following

a) Design tab b) Visual guides c) Column chart d) Insert tab

V Fill the crossword

1) Sunburst  2) Pareto 3) Waterfall     4) Histogram 5) Treemap

VI Name the following option in the conditional formatting button

1) Colour scale 2) Data bars 3) Icons sets 4) Top/Bottom rules

VII Answer the following

1) It is used to format selected cell or cells that meet a specific condition based on values or
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4) Auto Fill is the easiest method to fill data in cells automatically. It is used to fill a series of 

    numbers, number and text combination and dates or time periods based on a pattern. 

    Flash fill feature that fills the data in cells by picking up the pattern set.

5) (A)  G20 (B) H50

6) Text Formula, Numeric Formula, Logical Formula

7) Spreadsheet contains data and information arranged in rows and columns. It is also 

    called worksheets. A workbook is made up of one or more worksheet. Default 3 

    worksheets in  a workbook.
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1) Data bars       2) Gridlines       3) Chart       4) Treemap chart       5) Sunbrust chart
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III State whether True or False

1) False 2) True 3) True 4) True 5) False 6) True

IV Match the following

a) Design tab b) Visual guides c) Column chart d) Insert tab

V Fill the crossword

1) Sunburst  2) Pareto 3) Waterfall     4) Histogram 5) Treemap

VI Name the following option in the conditional formatting button

1) Colour scale 2) Data bars 3) Icons sets 4) Top/Bottom rules

VII Answer the following

1) It is used to format selected cell or cells that meet a specific condition based on values or
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           \t :- Tab \” :- Double quote \f :- ASCII Form feed

\\ :- Backslash \a :- ASCII Bell \r :- ASCII Carriage Return

\v :- ASCII Vertical Tab

3) The following base data types are used in python.

a)  Integer :- 12,-999,0,3434, etc       b) Real numbers :- 4.5 ,-25.4211,0.00003 etc

c) Characters:- ‘hello’, ‘100’,’$##$’, etc

4) 1 Can be of any size.

2 Have allowed characters, which are a-z, A-Z, 0-9 and underscore (_)

3 Should begin with an alphabet or underscore. 4  Should not be a keyword.

5) print('1\n1\t2\n')

print('1\t2\t3\n')

print('1\t2\t3\t4\n')

print('1\t2\t3\t4\t4\n') 

I      Fill in the blanks

1. Security breaches 2. First wave of AI     3. Machine learning  4. AI

5. Third wave 6. Self driving Car

II      Write T for True and F for False 1. T 2.  T 3.  T 4. T 5.  T  6.  F

III        Multiple Choice Question

1. Second 2. Traffic management 3. First 4. Intelligent security

IV     Answer the following

1. In intelligent security is a system in which you can configure central automation system 

    to take necessary actions instantly. You will receive instant alerts in case of  security 

    breaches Whereas in safety and security AI enabled CCTV  help in building surveillance 

    system to keep a check on potential criminal incidents and security of the residents.

2. Smart highways gives SMS alerts on traffic and medical information in case of medical 

   emergencies and requirements. No red lights, no parking troubles, sound and air pollution 

   free environments are some of the other important features of smart highways.

3.  AI enabled homes will let us turn on our lights, play favourite music or change our 

    room temperature, by tapping the app on our Smartphones. We can have our coffee 

    ready when we wake up, automatically turn on and off AC’s, lights, fans etc. 

4. Safety and security, Automated transportation.

5. The first wave of AI, are machines that follow rules defined by a man, which involves 

   expert system such as chatbots. The second wave of AI based on machine learning,which 

    included the systems that were designed to learn and perceive. The third wave of AI is 

    contextual adaption. It had system that receive, understand and process applications 

    without human intervention.

ITG-VII 7 MORE ON PYTHON

3) A valid function should be in sequential order. A set of rules for doing something is  

    an orderly manner is called Syntax.

4) MAX function returns the highest number in the selected range.

   Example:= MAX (B2:B6) returns 96

   MIN function returns the smallest in the selected range.

   Example: = MIN (B2:B6) returns 20

5) Date and Time functions are used to display the date or time in a cell. It can also 

    make some calculations. Example: To know the date after fifty days from the current 

    date, type the formula as: =Today ()+50.

6) SUMIF function adds the values in cells specified by a given condition or criteria. 

    The main advantage of this function is, it can add the number that meets the given 

    condition or you can make the sum range of cells or a column with respect to the data 

    in another column.

7) LEFT It returns the first character or characters in a text string, based on the number 

    of characters that you specify. Example:= LEFT(”GOOD LUCK”,2) returns “GO”.

8) COUNTIF function counts the number of cells within a range that meet a given 

    condition. Syntax: = COUNTIF (range, criteria) the following function is used to check 

    number of students earning marks above 160.

I Fill in the blanks1) Type() 2) Constants      3) Input() 

II Answer the Following

1) Constants are variables whose values do not change during the lifetime of the program. 

Unlike languages like C or Java; Python doesn’t have a special syntax to create 

constants. We have created constants just like ordinary variables. However, to separate 

them from an ordinary variable, we use all uppercase letters.

>>>

>>> MY_CONST = 100 # a constant

>>>

You are even allowed to change the value of MY_CONST constant by assigning new 

value to it as follows:

>>>

 >>> MY_CONST = "new value”

2) Escape sequences are set of special characters used to print characters which can’t be 

typed directly using the keyboard. Each escape sequences starts with a backlash 

character. The following are some common escape sequences.

\n :- Newline  \’ :- Single quote      \b :- ASCII Backspace  
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III        Multiple Choice Question

1. Second 2. Traffic management 3. First 4. Intelligent security
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    to take necessary actions instantly. You will receive instant alerts in case of  security 

    breaches Whereas in safety and security AI enabled CCTV  help in building surveillance 

    system to keep a check on potential criminal incidents and security of the residents.

2. Smart highways gives SMS alerts on traffic and medical information in case of medical 

   emergencies and requirements. No red lights, no parking troubles, sound and air pollution 

   free environments are some of the other important features of smart highways.

3.  AI enabled homes will let us turn on our lights, play favourite music or change our 

    room temperature, by tapping the app on our Smartphones. We can have our coffee 

    ready when we wake up, automatically turn on and off AC’s, lights, fans etc. 

4. Safety and security, Automated transportation.

5. The first wave of AI, are machines that follow rules defined by a man, which involves 

   expert system such as chatbots. The second wave of AI based on machine learning,which 

    included the systems that were designed to learn and perceive. The third wave of AI is 

    contextual adaption. It had system that receive, understand and process applications 

    without human intervention.
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4) MAX function returns the highest number in the selected range.

   Example:= MAX (B2:B6) returns 96

   MIN function returns the smallest in the selected range.

   Example: = MIN (B2:B6) returns 20

5) Date and Time functions are used to display the date or time in a cell. It can also 

    make some calculations. Example: To know the date after fifty days from the current 

    date, type the formula as: =Today ()+50.

6) SUMIF function adds the values in cells specified by a given condition or criteria. 

    The main advantage of this function is, it can add the number that meets the given 

    condition or you can make the sum range of cells or a column with respect to the data 

    in another column.

7) LEFT It returns the first character or characters in a text string, based on the number 

    of characters that you specify. Example:= LEFT(”GOOD LUCK”,2) returns “GO”.

8) COUNTIF function counts the number of cells within a range that meet a given 

    condition. Syntax: = COUNTIF (range, criteria) the following function is used to check 

    number of students earning marks above 160.
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II Answer the Following
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Unlike languages like C or Java; Python doesn’t have a special syntax to create 
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>>>

>>> MY_CONST = 100 # a constant

>>>

You are even allowed to change the value of MY_CONST constant by assigning new 

value to it as follows:

>>>

 >>> MY_CONST = "new value”

2) Escape sequences are set of special characters used to print characters which can’t be 

typed directly using the keyboard. Each escape sequences starts with a backlash 

character. The following are some common escape sequences.

\n :- Newline  \’ :- Single quote      \b :- ASCII Backspace  

40 41

ITG-VII 8 FUTURE OF ARTIFICIAL INTELLIGENCE



6) Network protocol is a set of rules which is used by computers to communicate with 

    each other across a network. Some protocols used in networks are:TCP/IP, HTTP, FTP

7) One of the largest cyberattacks ever is currently eating the web, hitting PCs in countries 

    and businesses around the world. It was attacked certain systems on May 2017 world  

    wide cyberattack by the WannaCray ransomware cryptoworm.

I Fill in the blanks

1) <A>     2) ............................ tag is used to design frame. - <FRAME>

3) Nested list     4) <TH> 5) BORDERCOLORLIGHT 6) Rowspan 7) Table

8) Colspan     9) Hyperlink 10) Forms

II Match the following

1) <LI> 2) <OL>     3) <DL>     4) <TD>     5) <TR>     6) <A>     

7) Email linking

III Write the Syntax of the following tags

1) Form tag: <form> .......</form> 2) Hyperlink : <a>...........</a>

3)Anchor tag : <a href=”url” text> </a> 4) colspan : <td colspan = “number”>

5) Frame tag : <frame src = “html”> 

IV True or False 1) False  2) True  3) False   4) False   5) False  6) False   7) True   8) True

V Tick the correct option

1) Bordercolor       2) <OL> 3) Hyperlinks       4) <BR>          5) Cellspacing

VI Write the HTML commands for the following

1) <TABLE BORDER=BGCOLOR=BLUE CELLPADDING = 4>

2) <UL TYPE= “SQUARE”> 3) <TH ALIGN = “center”> month </th>

4) To create a colspan of 3 with bgcolor red and center align- <TD colspan= 3 

    bgcolor=”red” align=”center”>......</TD>

5) <a href = “https://accounts.google.com” </a>

6) <input type = “checkbox” name = “toon” value = “Bug”> Bug

    <TEXTAREA rows = 20 cols = 40>...............................</TEXTAREA> 

VII Answer the following

1) List are used to group related pieces of information together. There are three different 

    types of list, they are

*  <UL> - Unordered list:  An unordered list is used when the items are to be displayed in    

    any particular sequence.

*  <OL> - Ordered list: Ordered list specifies items in sequential, numerical order.

*  <DL> - Definition list: A definition list is a list of items, with a description of each item.

2) <TH>   The <TH> tag defines a header cell in an HTML table.

ITG-VIII 2 MORE ON HTML

I Fill in the blanks

1) Internet      2) Network protocol       3) Wired      4) Malicious software

5) LAN 6) WannaCry

II State whether True or False

1) False 2) True 3) True 4) True 5) False

III Match the following

1) US Defense 2) Antivirus 3) CAN 4) FTP 5) Malware

IV Expand the following

1) Hyper Text Markup Language 2) Hyper Text Transfer Protocol

3) File Transfer Protocol 4) Wide Area Network 5) Local Area Network

V Fill the Pyramid

1) Intranet 2) ARPANET      3) Norton      4) Virus    5) Worm     6) LAN

VI Identify the following networks

1) Personal Area Network  2) Local Area Network  3) Wide Area Network 

4) Metropolitan Area Network  5) Campus Area Network

VII Who am I?

`1) Intranet 2) Extranet  3) Internet 4) WannaCry

VIII Answer the following

1) A computer network is a group of interconnected computers through cables, telephone

    lines, radio waves, satellites or infrared light beams.

2)File Transfer Protocol is used to transfer a file from one system to another, under the 

   command of FTP user.

3)Local Area Network (LAN) is a computer network covering a small physical area 

   such as home, office, school, airport, hospital etc. 

    Wide Area Network (WAN) spans a wide geographical area such as cities, countries, 

   continents or even the whole of the world. WANs may transmit data over high-speed     

    phone lines or wireless links such as satellites to cover long distance. The world’s 

    most popular WAN is the Internet.

4) Internet is a global communication accessed through the web.

    Intranet is the shared content accessed by members within a single organization.

5) Malware is short form of malicious software. It is a type of destructive software program

    that can reproduce itself and spread from one computer to another. It becomes installed 

    on a computer without the knowledge of the person using computer. Malware includes

   computer viruses, worms, Trojan horses, Spyware, Adware and other malicious software.

ITG-VIII 1 NETWORK AND SECURITY
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6) Network protocol is a set of rules which is used by computers to communicate with 

    each other across a network. Some protocols used in networks are:TCP/IP, HTTP, FTP
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*  <OL> - Ordered list: Ordered list specifies items in sequential, numerical order.

*  <DL> - Definition list: A definition list is a list of items, with a description of each item.

2) <TH>   The <TH> tag defines a header cell in an HTML table.
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1) Hyper Text Markup Language 2) Hyper Text Transfer Protocol

3) File Transfer Protocol 4) Wide Area Network 5) Local Area Network

V Fill the Pyramid
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VI Identify the following networks

1) Personal Area Network  2) Local Area Network  3) Wide Area Network 

4) Metropolitan Area Network  5) Campus Area Network

VII Who am I?

`1) Intranet 2) Extranet  3) Internet 4) WannaCry

VIII Answer the following

1) A computer network is a group of interconnected computers through cables, telephone

    lines, radio waves, satellites or infrared light beams.

2)File Transfer Protocol is used to transfer a file from one system to another, under the 

   command of FTP user.

3)Local Area Network (LAN) is a computer network covering a small physical area 

   such as home, office, school, airport, hospital etc. 

    Wide Area Network (WAN) spans a wide geographical area such as cities, countries, 

   continents or even the whole of the world. WANs may transmit data over high-speed     

    phone lines or wireless links such as satellites to cover long distance. The world’s 

    most popular WAN is the Internet.

4) Internet is a global communication accessed through the web.

    Intranet is the shared content accessed by members within a single organization.

5) Malware is short form of malicious software. It is a type of destructive software program

    that can reproduce itself and spread from one computer to another. It becomes installed 

    on a computer without the knowledge of the person using computer. Malware includes
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ITG-VIII 3 MORE TAGS ON HTML

VI Fill the Crossword 1) Tables 2) Fields 3) Reports 4) Query

VII Answer the following

1) A database is an organized collection of related data so that it can be easily accessed, 

    managed and updated.  MS Access, Oracle and SQL.

2) Primary key is a field or combination of fields that uniquely identifies records in a table.

3) Select any record that needs to be deleted then click on drop down arrow of Delete 

    option in the record group in Home tab. Select Delete Record.

4) Short Text, Long Text, Number, Currency, Date/Time, Auto Number, Yes/No, 

    Hyperlink, Memo.

    Long Text: This data type allows to store lengthy texts, that is up to 65536 characters.

    Hyperlink: Text and numbers stored as text and used as a hyperlink address.

5) A record consists fields. Where as Data organized in columns of a table is called Fields

6) Save Time, Save Money, Avoid Data Redundancy, Data Security

VIII Write one word questions about Data Type

1) Memo     2) Primary Key     3) Yes/No      4) Short Text     5) Currency      6) Number

IX Find out the following    1) 5   2) 3  3) OrderList. accdb    4) Currency    5) Datasheet view

X Identify the following

1) Object Tab              2) Field Grid Pane     3) 255 4) Field Properties Pane

1) Primary Key 2) Tools Group

I Fill in the blanks

1) Or 2) Layout 3) Show 4) A query 5) Sort 6) Form

7) Header/ Footer 8) Queries

II Match the following

1) Report View 2) Print View 3) Layout View 4) Design View

5) Show Table 6) Run 7) Report 8) Form

III State True or False    1) False     2) True     3) True  4) True     5) False     6) False

IV Identify the following

1) Field List pane     2) Report       3) Design grid    4) Print Preview      5) Run

V Mark the following part of the Query windows

ITG-VIII 4 INTRODUCTION TO MS ACCESS

     <TD>   The <TD> tag stands for table cell. It defines a standard cell in a HTML table

3) COLSPAN: Table cells can span across more than one column or row. The attribute 

    COLSPAN specifies width of the cell in terms of number of columns used when a cell 

    occupies more than one column.

    ROWSPAN sets how many rows a cell spans. The ROWSPAN attribute specifies the 

    number of rows a cell should span. It decides the height of the cell in terms  of  number of 

    rows used when a cell occupies more than one row.

4) Forms are used to accept input from a user. It includes checkbox, radio button, list etc.

5) Frames allow you to have multiple sections of the browser window.

6) External linking, Internal linking, Email linking

I Fill in the blanks

1) SRC 2) HSPACE 3) MARGINHEIGHT     4) Scrollbars     5) FRAMESET

II Answer the following

1) Align=Top - Align the text to the left or right top corner of the image.

    Align=Middle  - Align the text to the left or right middle part of the image.

    Align=Left  - Align the image to the left margin.

2) Frame tag is used to display more than one web page in the same browser window - even

     webpages from other web sites.

3) Marginheight - It specifies top and bottom margins of the content of the frame in pixels.

     Marginwidth - It specifies the width between the content and left and right sides of the     

    frame in pixels.

    Scrolling - It specifies the window can have scrollbars or not, by setting the values as Yes, 

    No, Auto.

I Fill in the blanks

1) Data 2) Database     3) ab.accdb  4) Records     5) Fields

6) Table1 7) Id     8) Primary key 9) Short text   10) Design

II Write the example for Data types   1) Address   2) Phone number   3) Rupees   4) DOB

III State  whether True or False

1) True       2) False      3) True      4) True      5) False      6) True      7) True     8) False

IV Multiple choice question  1) RDBMS  2) Design View  3) 255  4) Long Text  5) Save Time

V Match the following

1) Create a new record 2) Save record 3) Delete record 

4) Descending order 5) Datasheet View
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VI Fill the Crossword 1) Tables 2) Fields 3) Reports 4) Query

VII Answer the following

1) A database is an organized collection of related data so that it can be easily accessed, 

    managed and updated.  MS Access, Oracle and SQL.

2) Primary key is a field or combination of fields that uniquely identifies records in a table.

3) Select any record that needs to be deleted then click on drop down arrow of Delete 

    option in the record group in Home tab. Select Delete Record.

4) Short Text, Long Text, Number, Currency, Date/Time, Auto Number, Yes/No, 

    Hyperlink, Memo.

    Long Text: This data type allows to store lengthy texts, that is up to 65536 characters.

    Hyperlink: Text and numbers stored as text and used as a hyperlink address.

5) A record consists fields. Where as Data organized in columns of a table is called Fields

6) Save Time, Save Money, Avoid Data Redundancy, Data Security

VIII Write one word questions about Data Type

1) Memo     2) Primary Key     3) Yes/No      4) Short Text     5) Currency      6) Number

IX Find out the following    1) 5   2) 3  3) OrderList. accdb    4) Currency    5) Datasheet view

X Identify the following

1) Object Tab              2) Field Grid Pane     3) 255 4) Field Properties Pane

1) Primary Key 2) Tools Group

I Fill in the blanks

1) Or 2) Layout 3) Show 4) A query 5) Sort 6) Form

7) Header/ Footer 8) Queries

II Match the following

1) Report View 2) Print View 3) Layout View 4) Design View

5) Show Table 6) Run 7) Report 8) Form

III State True or False    1) False     2) True     3) True  4) True     5) False     6) False

IV Identify the following

1) Field List pane     2) Report       3) Design grid    4) Print Preview      5) Run

V Mark the following part of the Query windows

ITG-VIII 4 INTRODUCTION TO MS ACCESS

     <TD>   The <TD> tag stands for table cell. It defines a standard cell in a HTML table

3) COLSPAN: Table cells can span across more than one column or row. The attribute 

    COLSPAN specifies width of the cell in terms of number of columns used when a cell 

    occupies more than one column.

    ROWSPAN sets how many rows a cell spans. The ROWSPAN attribute specifies the 

    number of rows a cell should span. It decides the height of the cell in terms  of  number of 

    rows used when a cell occupies more than one row.

4) Forms are used to accept input from a user. It includes checkbox, radio button, list etc.

5) Frames allow you to have multiple sections of the browser window.

6) External linking, Internal linking, Email linking

I Fill in the blanks

1) SRC 2) HSPACE 3) MARGINHEIGHT     4) Scrollbars     5) FRAMESET

II Answer the following

1) Align=Top - Align the text to the left or right top corner of the image.

    Align=Middle  - Align the text to the left or right middle part of the image.

    Align=Left  - Align the image to the left margin.

2) Frame tag is used to display more than one web page in the same browser window - even

     webpages from other web sites.

3) Marginheight - It specifies top and bottom margins of the content of the frame in pixels.

     Marginwidth - It specifies the width between the content and left and right sides of the     

    frame in pixels.

    Scrolling - It specifies the window can have scrollbars or not, by setting the values as Yes, 

    No, Auto.

I Fill in the blanks

1) Data 2) Database     3) ab.accdb  4) Records     5) Fields

6) Table1 7) Id     8) Primary key 9) Short text   10) Design

II Write the example for Data types   1) Address   2) Phone number   3) Rupees   4) DOB

III State  whether True or False

1) True       2) False      3) True      4) True      5) False      6) True      7) True     8) False

IV Multiple choice question  1) RDBMS  2) Design View  3) 255  4) Long Text  5) Save Time

V Match the following

1) Create a new record 2) Save record 3) Delete record 

4) Descending order 5) Datasheet View
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     The Export- RTF file dialog box appears on the screen. Click OK.

    Select the location to save and type the Word file name in textbox. Click Close.

I Fill in the blanks

1) Thomas and John Knoll 2) Tools panel       3) Panels      4) Resolution

5) Warping 6) Eye 7) Marquee       8) Shift + Ctrl+ N       

9) Color Replacement 10) Sponge

II Identify the following tools

1) Create New folder 2) Magnify tool 3) Magic want tool 4) Pen tool

5) Crop tool 6) Art History Brush 7) Colour Replacement 8) Brush tool

III Expand the following abbreviations

1) Photoshop Document 2) Joint Photographic Expert Group

3) Graphic Inter Change Format 4) Cyan, Magenta, Yellow, Key (Black)

5) Red, Green, Blue 6) Tagged Image File Format

IV Choose the correct answer

1) Marquee 2) Type 3) Crop 4) psd 5) Ctrl +D

6) Spot Healing 7) Clone stamp 8) Magnify 9) 10) Linear

V State whether True or False 1) False    2) True    3) False   4) False    5) True    6) True

VI Crossword for the following tools

Across :- 1) Lasso 2) Pen 3) Brush 4) Magic Wand

Down:- 1) Dodge 2) Layers 3) Crop 4) Move

VII Look at the picture given here and answer the questions that follow

1) Lasso tool   2) Eraser tool     3) Color Replacement tool  4) Layer

VIII Answer the following

1) A user- friendly interface, Advanced image adjustments, Edit motion based material,

    Produce multiple or complex images, Create graphics with reduced file size.

2) Marquee Tool, Lasso Tool, Move tool, Quick Selection Tool

3) It provides options related to the tool currently selected in the Tools panel. For example, 

    to choose the thickness of the Brush Tool selected in the Tools panel, we use Option bar.

4) Rectangle Marquee Tool, Elliptical Marquee Tool, Single Row Marquee Tool, Single

    Column Marquee Tool.

5) Smudge Tool:-  It is used to smear the paint on  canvas. It gives an effect finger painting.

    Dodge Tool :- This tool is used to lighten the dark areas of the image.

6) Layers are the transparent sheets that can hold objects and are stacked or moved to create

    the image composition. They allow the users to draw, edit, paste and reposition elements  

    on one layer without disturbing the others.

ITG-VIII 6 CHART WITH REPORT

VI Answer the following        

1) A form is a database object that you can use to enter, edit, or display data from table.   

    There are three view: Form View, Layout View, Design View.   

2) A report is a database object that is used to organize and display data pulled from table or

    queries. Report is an effective way to organize and summarize data for viewing /printing.

3) Click the down arrow under View option in View group on the Home tab or Design tab. 

    Click on the Print Preview tab. The report is displayed in the manner in which it would 

    appear on a page.

    Choose appropriate values for Page Size, Margin and Orientation from the Ribbon.

    Click on the Print command to print the report, then click Close Print Preview.

4) Query window is divided into two panes. Top and Bottom. The top pane display the 

    tables selected for the query. Bottom pane displays a design grid where you can add field 

    to query and also specify the criteria. The design grid contains Field, Table, Sort, Show, 

   or and Criteria

5) Report View, Print Preview, Layout View, Design View

6) To create a Form, select a table in the Navigation Pane that you want to use as data source

   for the form and follow the given steps :  Click the Create tab on the ribbon. Select the 

    Form in the Forms group. A form is created and it opens in the Layout View. There are 

   three new tabs: Design, Arrange and Format appear in the Ribbon and then save the Form.

   

I Fill in the blanks

1)Chart         2)Create      3)Legend         4)Layout       5)Control 

6)Menu bar         7)External data      8)Outline

II Match the following

1) Controls     2) Report Wizard     3) Landscape     4) External Data     5) Blank Report

III Write the name of  Group/Tab 

1) Export 2) Create 3) Controls 4) Reports 5) Reports

IV State True or False     1) False      2) False      3) True     4) False      5) True

V Answer the following

1) A chart is a graphical representation of data. There are two basic part :  body and  legend.

2) To modify group/ sort in an existing report, to select a particular field for grouping click 

    the arrow for change the order then select any field for sort click it in the ascending or

    descending order.

3) There are three layout in a report. 1) Stepped, 2) Block, 3) Outline

4) Open the table Office _ Address _ List and click on the Word tool on Export Group in 

    External Data tab.  
46 47

ITG-VIII 7 ADOBE PHOTOSHOP



     The Export- RTF file dialog box appears on the screen. Click OK.

    Select the location to save and type the Word file name in textbox. Click Close.

I Fill in the blanks

1) Thomas and John Knoll 2) Tools panel       3) Panels      4) Resolution

5) Warping 6) Eye 7) Marquee       8) Shift + Ctrl+ N       

9) Color Replacement 10) Sponge

II Identify the following tools

1) Create New folder 2) Magnify tool 3) Magic want tool 4) Pen tool

5) Crop tool 6) Art History Brush 7) Colour Replacement 8) Brush tool

III Expand the following abbreviations

1) Photoshop Document 2) Joint Photographic Expert Group

3) Graphic Inter Change Format 4) Cyan, Magenta, Yellow, Key (Black)

5) Red, Green, Blue 6) Tagged Image File Format

IV Choose the correct answer

1) Marquee 2) Type 3) Crop 4) psd 5) Ctrl +D

6) Spot Healing 7) Clone stamp 8) Magnify 9) 10) Linear

V State whether True or False 1) False    2) True    3) False   4) False    5) True    6) True

VI Crossword for the following tools

Across :- 1) Lasso 2) Pen 3) Brush 4) Magic Wand

Down:- 1) Dodge 2) Layers 3) Crop 4) Move

VII Look at the picture given here and answer the questions that follow

1) Lasso tool   2) Eraser tool     3) Color Replacement tool  4) Layer

VIII Answer the following

1) A user- friendly interface, Advanced image adjustments, Edit motion based material,

    Produce multiple or complex images, Create graphics with reduced file size.

2) Marquee Tool, Lasso Tool, Move tool, Quick Selection Tool

3) It provides options related to the tool currently selected in the Tools panel. For example, 

    to choose the thickness of the Brush Tool selected in the Tools panel, we use Option bar.

4) Rectangle Marquee Tool, Elliptical Marquee Tool, Single Row Marquee Tool, Single

    Column Marquee Tool.

5) Smudge Tool:-  It is used to smear the paint on  canvas. It gives an effect finger painting.

    Dodge Tool :- This tool is used to lighten the dark areas of the image.

6) Layers are the transparent sheets that can hold objects and are stacked or moved to create

    the image composition. They allow the users to draw, edit, paste and reposition elements  

    on one layer without disturbing the others.

ITG-VIII 6 CHART WITH REPORT

VI Answer the following        

1) A form is a database object that you can use to enter, edit, or display data from table.   

    There are three view: Form View, Layout View, Design View.   

2) A report is a database object that is used to organize and display data pulled from table or

    queries. Report is an effective way to organize and summarize data for viewing /printing.

3) Click the down arrow under View option in View group on the Home tab or Design tab. 

    Click on the Print Preview tab. The report is displayed in the manner in which it would 

    appear on a page.

    Choose appropriate values for Page Size, Margin and Orientation from the Ribbon.

    Click on the Print command to print the report, then click Close Print Preview.

4) Query window is divided into two panes. Top and Bottom. The top pane display the 

    tables selected for the query. Bottom pane displays a design grid where you can add field 

    to query and also specify the criteria. The design grid contains Field, Table, Sort, Show, 

   or and Criteria

5) Report View, Print Preview, Layout View, Design View

6) To create a Form, select a table in the Navigation Pane that you want to use as data source

   for the form and follow the given steps :  Click the Create tab on the ribbon. Select the 

    Form in the Forms group. A form is created and it opens in the Layout View. There are 

   three new tabs: Design, Arrange and Format appear in the Ribbon and then save the Form.

   

I Fill in the blanks

1)Chart         2)Create      3)Legend         4)Layout       5)Control 

6)Menu bar         7)External data      8)Outline

II Match the following

1) Controls     2) Report Wizard     3) Landscape     4) External Data     5) Blank Report

III Write the name of  Group/Tab 

1) Export 2) Create 3) Controls 4) Reports 5) Reports

IV State True or False     1) False      2) False      3) True     4) False      5) True

V Answer the following

1) A chart is a graphical representation of data. There are two basic part :  body and  legend.

2) To modify group/ sort in an existing report, to select a particular field for grouping click 

    the arrow for change the order then select any field for sort click it in the ascending or

    descending order.

3) There are three layout in a report. 1) Stepped, 2) Block, 3) Outline

4) Open the table Office _ Address _ List and click on the Word tool on Export Group in 

    External Data tab.  
46 47

ITG-VIII 7 ADOBE PHOTOSHOP



A Fill in the blanks  

1. Siri  2. Apple store  3. Uber and Ola  4. AI  5. Entertainment  6. Predict

B Multiple choice question

1. Cortana   2. a and b       3. Tesla  4. Autonomous cars 

5. SwiftKey   6. Health       7.  Drug design

C Write T for True and F for False

1. T    2.T     3. T   4. T    5. F   6. T  7. T  8. T

D Match the following

1.  Predicting effects of medicine in patients   

2.  Make services more efficient and simplified 3. Observing crop and soil health

4. Personalized product recommendations 5.  Virtual and intelligent tutoring systems

6. Improved visual and audio quality 7.  Friend suggestions on social media  

8. Control and access of devices in your home 

E Differentiate between the following

Tesla is one of the leading car manufacturing companies when it comes to self driving 

technology.

Siri is Apple's personal assistant for iOS, macOS, tvOS and watch OS devices that uses 

voice recognition and is powered by artificial intelligence.

F Answer the following

1. Some examples of  AI apps are Google Assistant, Siri, Youper and SwiftKey etc.

2. Smart Cities are urban areas, uses different types of electronic applications and sensors 

    to collect data. Data is used to improve the operation of the city.

3. Self driving vehicles,  known as autonomous / 'driverless' cars, can combine sensors and

    software to control, navigate and drive itself on its own. They don't need human drivers 

    to control / operate vehicle in a safe manner. Tesla is an example of self driving cars.

4. Smart home has security features to protect ourselves and our properties. Which have 

    control and easy access of devices within your home.

5. AI in Agriculture is bringing more quality and yield than before. AI technologies have 

    been applied aggressively towards agro based production and has proven to be fruitful. 

    AI enabled technologies can help recognize possible defects and nutrient deficits in soil.

6. AI can solve issues surrounding education quality and its access within the education 

    sector. AI is enhancing learning experience through personalized sessions, automating 

    and speeding up school administrative tasks, predicting the need for students/teachers 

    communication to reduce academic failures etc. 
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